Notices


No part of this manual may be reproduced in any form or by any means (including electronic storage and retrieval or translation into a foreign language) without prior agreement and written consent from Agilent Technologies, Inc. as governed by United States and international copyright laws.

Manual Part Number
G2181-90018

Edition
02/09

Printed in Germany
Agilent Technologies
Hewlett-Packard-Strasse 8
76337 Waldbronn, Germany

Microsoft ® is a U.S. registered trademark of Microsoft Corporation.

Software Revision

This handbook is for a module of the Agilent ChemStation Plus software. In the section “In This Guide...” on page 3 you will find details about the module and the revision of the module that this book is intended to be used for.

Warranty

The material contained in this document is provided “as is,” and is subject to being changed, without notice, in future editions. Further, to the maximum extent permitted by applicable law, Agilent disclaims all warranties, either express or implied, with regard to this manual and any information contained herein, including but not limited to the implied warranties of merchantability and fitness for a particular purpose. Agilent shall not be liable for errors or for incidental or consequential damages in connection with the furnishing, use, or performance of this document or of any information contained herein. Should Agilent and the user have a separate written agreement with warranty terms covering the material in this document that conflict with these terms, the warranty terms in the separate agreement shall control.

Technology Licenses

The hardware and/or software described in this document are furnished under a license and may be used or copied only in accordance with the terms of such license.

Restricted Rights Legend

If software is for use in the performance of a U.S. Government prime contract or subcontract, Software is delivered and licensed as “Commercial computer software” as defined in DFAR 252.227-7014 (June 1995), or as a “commercial item” as defined in FAR 2.101(a) or as “Restricted computer software” as defined in FAR 52.227-19 (June 1987) or any equivalent agency regulation or contract clause. Use, duplication or disclosure of Software is subject to Agilent Technologies’ standard commercial license terms, and non-DOD Departments and Agencies of the U.S. Government will receive no greater than Restricted Rights as defined in FAR 52.227-19(c)(1-2) (June 1987). U.S. Government users will receive no greater than Limited Rights as defined in FAR 52.227-14 (June 1987) or DFAR 252.227-7015 (b)(2) (November 1995), as applicable in any technical data.

Safety Notices

CAUTION

A CAUTION notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in damage to the product or loss of important data. Do not proceed beyond a CAUTION notice until the indicated conditions are fully understood and met.

WARNING

A WARNING notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in personal injury or death. Do not proceed beyond a WARNING notice until the indicated conditions are fully understood and met.

Agilent ChemStore C/S Installation Guide
In This Guide...

This guide contains information to install the ChemStore B.04.02 or higher on both a stand-alone and client/server installation.

The guide is organized as follows:

1 Introduction

You can run ChemStore either as a standalone database application, or as part of a client/server system. Refer to this introduction for more details on both versions.

Installation Tasks

The following chapters show you how to perform both standalone and client/server installations of ChemStore C/S.

2 Standalone Installation

This chapter explains how to install the Standalone version of ChemStore.

3 Client/Server Installation

This chapter describes how to install and configure the ChemStore server, as well as how to install ChemStore Data Management Modules for use in a client/server configuration.

Upgrading and Migration Tasks

The following chapters describe the various procedures necessary to upgrade from previous revisions of the ChemStore software as well as the procedure to upgrade a standalone system to client/server.

4 Upgrading ChemStore Standalone to Client/Server

This chapter describes the steps necessary to upgrade a stand-alone installation of ChemStore revision B.04.02 or higher to Client/Server.

5 Upgrading Standalone Installations

This chapter describes the steps necessary to upgrade your standalone installation from a previous revision to revision B.04.02 or higher.
6 Upgrading Client/Server Installations

This chapter describes the process involved in upgrading your client/server installation from previous revisions to revision B.04.02 or higher.

Advanced Topics

The following chapters describe troubleshooting tips, un-installation tasks, administrative tasks, and reference information.

7 Troubleshooting Tips

This chapter describes troubleshooting tips for problems that may arise during installation.

8 Removing Client Software

This chapter describes the procedures to correctly un-install the ChemStore and Oracle software from your client and standalone systems.

9 Removing Server Software

This chapter describes the procedures to correctly un-install ChemStore C/S and Oracle software from your server.

10 Administration and Reference Information

This chapter describes administrative tasks and reference information for ChemStore C/S.
Contents

1 Introduction 11
   Standalone Data Management Module 12
   Client/Server Version 13

2 Standalone Installation 15
   Requirements 16
   Planning 17
   Installation Procedure 20
   Creating and Connecting to the Database 22
      Creating a New Database 22
      Connecting to the Database 24
   Installation and Configuration of the Agilent Technologies DB Size Security Service 28
      Installation 28
      Configuration 29
      Un-install Information 30

3 Client/Server Installation 31
   Requirements 33
      Client Hardware 33
      Client Software 33
      Server Hardware 34
      Server Software 35
   Planning 36
      Database Size 36
Contents

Store in Addition Settings of a Study 37
Agilent ChemStation Techniques 38
Server Performance Considerations 39
Infrastructure Server Roles 40
Authentication Considerations 40
Network Considerations 41
License Considerations 41

Server Installation 42
  Install Oracle 10g Database Management Software 42
  Install the Oracle 10g database Patch Set 10.2.0.4.0 46
  Configuring the TNS Listener Service 48
  Configuring the Net Service Name 50
  Testing Net Communications 55
  Install ChemStore C/S Server Software 56
  Create the Oracle Database 60
  Completing the Installation 65
  Install Oracle 10g database Critical Patch Updates (optional) 66

Client Installation 67
  Install Oracle 10g Client Software on Windows Vista 67
  Install the Oracle 10g Client Patch Set 10.2.0.4.0 71
  Running the Net Configuration Assistant 73
  Testing Net Communications 74
  Installing ChemStore Data Management Module 75
  Connecting to the Database 80
  Completing the Installation 81

4 Upgrading ChemStore Standalone to Client/Server 83
General information 84

  Installing the Client/Server Connectivity Software 85
    Installing Oracle 10g Client Software 85
    Upgrading the ChemStore C/S Client Software 86
    Completing the Installation 89
Contents

Connecting to the Server Database 90
Migrating Standalone Databases to the Server 93

5 Upgrading Standalone Installations 99
General information 100
Requirements 101
Preparation 102
Uninstallation and new installation 103
  Uninstall the Previous ChemStore Software 103
  Install the New Software Revision 103
Migrate Your Databases 104
  Connecting to the Database 105

6 Upgrading Client/Server Installations 107
General information 108
Upgrading Revision B.01.0x, B.02.0x or B.03.0x Server 110
  Set-up of development server or new production server 111
  Database export on production server 111
  Database import on development server or new production server 111
  Database Schema Migration Steps 112
  Completion Steps 112

7 Troubleshooting Tips 113
Troubleshooting Network Connections 114
Resolving Name Resolution Problems 115
Troubleshooting Net Connectivity 117
Troubleshooting Access Security Problems 120
Troubleshooting Installation Problems 122
  Checking the Server Log Files 122
Contents

Checking the Client Installation Log File 123

8 Removing Client Software 125
De-installing the ChemStore Client Software 126
Uninstalling Oracle 10g Client Software 129

9 Removing Server Software 131
Uninstalling ChemStore Server Software 132
Removing a ChemStore Server Database 134
De-installing Oracle 10g Server Software 136

10 Administration and Reference Information 139
Checking the Server Services 140
Installing the ChemStore C/S Admin Client Utility 142
Changing the Database Description 145
Changing the Default Passwords 147
ChemStore C/S internal user 147
Oracle Default Users 149
Shutting Down the Database Instance 151
Restarting the Database Instance 152
Backing Up the Database Files 153
Restoring the Database Files 155
Restoring the Database to a Different Server 156
Defragmenting disks and databases 157
Defragmenting the Server Disks 157
Defragmenting the Client Systems 158
Defragmenting server databases 158
Defragmenting client databases 163
Virus Protection 165
Power Failure Protection 166
Clearing the Archive Server Log File 167
Optimizing the Server Configuration 168
   Disable Unnecessary Databases 168
ChemStore C/S Files 169
ChemStore C/S default Users 171
   172
Index 173
You can run ChemStore either as a standalone database application, or as part of a client/server system.
Standalone Data Management Module

The ChemStore Data Management Module lets you create calculations, reports and charts to analyze your sample data. You can install the standalone version or the client/server version of the Data Management Module.

The standalone version of the ChemStore Data Management Module stores Agilent ChemStation data in a Microsoft Access database. Only data from the following Agilent ChemStation systems are supported:

- G1601BA Agilent ChemStation for CE
- G2070BA Agilent ChemStation for GC
- G2072BA Agilent ChemStation for A/D systems
- G2090BA Agilent ChemStation for 2D data analysis
- G2170BA Agilent ChemStation for 2D LC systems
- G2180BA Agilent ChemStation for LC spectral evaluation
- G2190BA Agilent ChemStation for 3D LC data analysis only
- G2710BA Agilent ChemStation for LC/MSD
- G2201BA Agilent ChemStation add-on for CE/MSD

Data acquired on corresponding GxxxxAA Hewlett-Packard or Agilent ChemStation systems are automatically migrated when loaded to a GxxxxBA ChemStation system. Further details can be found in the Upgrade Preparation Guide for ChemStation B.04.01 (P/N G2170-90230).

Use the standalone version, when you have a small number of samples (less than 1000) that you want to store per database and quarter and when your instruments and Agilent system share a single PC.

To run the standalone Agilent Data Management Module, you need:

- Agilent Data Management Module (G2181BA)
- Agilent ChemStation revision B.04.01
Client/Server Version

The client/server version of the Agilent Data Management Module uses the same user interface and supports the same Agilent ChemStation data types as the standalone Data Management Module. However, it stores its data in an Oracle database on a server system. Use the client/server version when you have a large number of samples (more than 1000 per quarter) and instruments on multiple PCs.

The client/server version offers all the capabilities of the standalone version, along with the following additional capabilities:

- Industry strength Oracle database for robust online storage of data
- Ability to create offline data archives and XML archive catalog files for archive management
- Multiple Agilent Data Management Modules and Agilent ChemStations sharing a single database
- Ability to report and compare data produced on different Agilent ChemStation systems within the same report.
- e-mail notification on security violation
- LIMS notification on result approval

You can upgrade from the standalone version to the client/server version. For instructions on doing this, see Chapter 4, “Upgrading ChemStore Standalone to Client/Server,” starting on page 83.

To run the client/server version of Agilent Data Management Module, you need:

- Agilent Server software (G1410A) installed on a dedicated database server.
- Agilent client connectivity software license G1411A, one per database user
- Agilent Data Management Module G2181BA or the Agilent Data Management Module licence G2186BA, one per client PC
- Agilent ChemStation revision B.04.01
1 Introduction
Client/Server Version
This chapter describes the steps necessary to install the ChemStore B.04.02 database application on a standalone system.

For instructions on installing Agilent ChemStation, see the ChemStation Installation Guide.

If you want to install the ChemStore client/server version, see Chapter 3, “Client/Server Installation,” starting on page 31.

If you already have a version of ChemStore installed on your system, refer to Chapter 4 and Chapter 5 for information on upgrading and migrating.

The ChemStore standalone installation adds the following items to the Windows Start menu (under All Programs > Agilent ChemStation):

- ChemStore Readme
- ChemStore Review Client
- ChemStore Utility
- Agilent Technologies DB Size Security Service (optional)
Requirements

The following list shows the minimum **hardware** requirements for this application used in combination with ChemStation rev. B.04.01 and Microsoft Vista (see Installation Manual G2181-90015 for Windows XP related requirements):

- 3.4 GHz - Pentium IV processor
- 4-GB free hard disk space
- 1 GB RAM for single and multi instrument configurations
- Display: 1280 × 1024; small fonts; 65-thousand colors

The following list shows the minimum **software** requirements for this application when installed on Windows Vista operating systems:

- Windows Vista Business with Service Pack 1
- Agilent ChemStation revision B.04.01 or later
- Microsoft Internet Explorer 7.0 or later
- A printer must be installed and configured in Windows for correct operation of the ChemStore C/S Data Management Module application.
- During the installation of ChemStore C/S a Microsoft Access 2007 runtime version will be installed. If you have already installed any older Microsoft Office product, there might be a conflict between the Microsoft Access Runtime from ChemStore C/S and the Microsoft Access components installed with Microsoft Office. Limited testing has been performed with MS Access 2003 and no issues have been found. If such a problem exists, you may be asked to remove the Microsoft Access components of Microsoft Office. Other components such as Microsoft Word, Powerpoint and Excel will not conflict with ChemStore C/S.
**Planning**

The standalone database size is limited to 800 MB due to requirements of the MS-Access database engine. While Microsoft publishes a specification of up to 2 GB, certain table-specific requirements result in a maximum database size for the ChemStore C/S application of 800 MB. If a larger single database is required, Agilent recommends that the client/server version of the product be purchased. The client/server database uses Oracle, which allows for a much larger database.

Due to the size restrictions of the Standalone database, some consideration should be given to what data will be stored and whether one or multiple databases will be used. You should also plan on a strategy for archiving the database once it has reached its maximum size. If it is planned to archive the database on CD-Recordable medium, then you should plan to keep the database under 650 MB in size.

The optional Agilent Technologies DB Size Security Service is a tool that warns you when a user-defined database size limit is exceeded. For installation of the service, see “Installation and Configuration of the Agilent Technologies DB Size Security Service” on page 28.

In general, you should plan on less than 1000 runs per standalone database. The actual number of runs that will fit within a single database depends on several factors:

- The use of custom fields (see *ChemStore Concepts Guide*)
- The number of compounds and peaks
- The Chromatographic technique
  (3D data requires more disk space than 2D data)
- The ChemStation report style
- The **Store in Addition** settings of the Study to which the run is assigned

Typical runs without the raw data use approximately 10 KB for a short report with 4 peaks, and use up to 300 KB per run for an extended performance report with 20 peaks. Refer to Table 1 on page 18 for guidance in calculating the amount of database space used by result data.
2  Standalone Installation
Planning

Table 1  Result Storage Requirements

<table>
<thead>
<tr>
<th>Number of Peaks</th>
<th>Agilent ChemStation Report Style</th>
<th>Run Length (minutes)</th>
<th>Approximate Size per Run (KB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Short</td>
<td>6</td>
<td>10</td>
</tr>
<tr>
<td>4</td>
<td>Short</td>
<td>30</td>
<td>40</td>
</tr>
<tr>
<td>4</td>
<td>Extended performance</td>
<td>6</td>
<td>80</td>
</tr>
<tr>
<td>20</td>
<td>Short</td>
<td>6</td>
<td>190</td>
</tr>
<tr>
<td>20</td>
<td>Extended performance</td>
<td>6</td>
<td>300</td>
</tr>
</tbody>
</table>

The Store in Addition tab in the Study settings allows you to specify the information that will be stored in the ChemStore C/S database for each run in addition to the result data. These options can be different for each study.

Table 2 on page 19 describes the different information types.
Selecting the options to store Raw Data, Sequence and Method will store the data files in compressed form in the database. The compression algorithm reduces the files size on average by 25% over the size of the data files on disk; however this data will still represent the vast majority of space used in the database. Selecting these options for a 2D detector results in approximately double the database usage per run. Raw data from a 3D detector such as a Diode Array Detector or Mass Spectrometer will result in data ten to twenty times the space required compared with storing just the results. Exactly how much space is required will depend on acquisition parameters. See the planning section in Chapter 3, “Client/Server Installation,” starting on page 31 for more details on raw data size considerations.

Once a database has reached the size limit of 800 Mbytes, you will not be able to add additional runs to the database. You will then need to start a new database for additional data. The ChemStore C/S Utility program allows you to create a new database based on an existing one so that critical configuration settings do not need to be manually re-entered.
Installation Procedure

Perform the following steps to install the ChemStore database client software on a standalone ChemStation system.

1. Log-on to Windows as a user with administrative capabilities.

2. Verify that the ‘Control Panel > Regional and Language options > Formats’ of the operating system are set to ‘English (United States)’. Time, Date, and Currency can be customized later on, but the number format must not be changed.

3. Verify the time zone settings and the clock to be set correctly. It is not recommended to keep the automated clock adjustment for daylight saving changes. The clock adjustment should be done manually at a dedicated time when all ChemStation applications are closed. These settings can be adjusted under Date and Time > Change Time Zone. Synchronization with the Windows internet time server need to be turned off, too.

4. Put the ChemStation Plus Client installation CD into the CD-ROM drive on your computer, open the Windows explorer and browse to the file \G2181\Setup.exe on the CD-ROM drive.

5. Right click the file setup.exe and run it as administrator

   The ChemStore set-up program will start and after confirming the Vista User Account Control dialog the program will lead you through a number of installation screens. Select Next at the information screen to proceed with the installation.

6. After accepting the Agilent Software License Agreement, you will be prompted for your software license/registration number. This number can be found on the yellow license packet that came with your software. Enter the number and click on the button Next to continue.

7. Enter the path to install the ChemStore C/S software. By default the software is installed in a subdirectory under the ChemStation directory (\chem32). If the installation is supposed to be extended by ChemStation Plus Security Pack, the installation path must not be different to the ChemStation installation path. Further on, the installation path must not contain blanks. You can configure the software to store the database in a separate location, such as on another local disk partition if you wish regardless of the location of the client software.

8. Click the button Next.
9 Select only **ChemStore - Client** and leave **Client/Server Connection** un-checked.

![ChemStore C/S - Review Client Installation Components](image)

**Figure 2** ChemStore Data Management Module Installation Components

10 Click the button **Next**.

11 When you see the confirmation screen, check the information on the dialog box. Click the button **Back** to change any of this information.

12 Click the button **Next** if this dialog box displays the correct information to proceed with the installation.

13 Restart your computer at the end of the installation when prompted to ensure proper operation of the installed software.

14 Continue with the installation of the optional ChemStation Plus Security Pack according to Security Pack User’s Guide (P/N G2183-90006)
Creating and Connecting to the Database

Creating a New Database

Before you begin using the ChemStore standalone Data Management Module, you need to create a ChemStore standalone database on your system and create users for the database. ChemStore ships with a tutorial (ChemStoreDemo.mdb) database for familiarization with the application, but it is recommended that you create an empty database for your data.

This step can be executed while a Windows Vista user is logged on. However, the ChemStore Utility application needs to be run as administrator, then.

1. Choose All Programs > Agilent ChemStation > ChemStore Utility from the Windows Start menu and run it as administrator.
2. Confirm the User Account Control message with Allow or enter the administrator’s password respectively.
3. Choose File > Create Access Database.

4. Click on Browse in the dialog box.
5. Enter a database name in the **File name** field of the **Save As** dialog box.

![Figure 4](image)  
**Figure 4**  
“Save as” dialog box

6. Click on **Save**.

7. The dialog box shows the path and name of the new database file. Click on **Create** to create the new database.

![Figure 5](image)  
**Figure 5**  
ChemStore database creation utility with selected database name
2 Standalone Installation
Creating and Connecting to the Database

8 A message box will notify you if the database was successfully created.

![Database creation confirmation](image)

**Figure 6** Database creation confirmation

9 You can now close the ChemStore Utility and start the ChemStore Data Management Module application to log-on to your new database.

**Connecting to the Database**

When you first start the ChemStore Data Management Module, you will need to create a database alias for your database before you can connect to the database. Each database in ChemStore must be given an alias. Follow these steps to connect to your new database. You can repeat this process for the demonstration database as well if you wish. With ChemStation Plus Security Pack installed you need to have Windows administrator privileges to select a database.

1 Log-on as a memeber of the Windows user group

2 Browse to **All Programs > Agilent ChemStation > ChemStore Review Client** from the Windows **Start** menu and do a right mouse click on the ChemStore Review Client icon.
3 Select Run as administrator

![Application start-up as administrator](image)

**Figure 7** Application start-up as administrator

4 At the user account control window enter a Windows administrator password

5 Click on the Select button in the log-on dialog to select a database. The database selection window will initially show no entries.

![ChemStore Log-On window](image)

**Figure 8** Initial ChemStore Log-On screen
2 Standalone Installation
Creating and Connecting to the Database

6 Select the **Browse** button from the selection window and select the database file you created in the previous section (or you may select the demonstration database).

![Database selection screen](image)

**Figure 9** Database selection screen

7 You will be prompted to enter an alias for this database. The alias is used to identify this database during the log-on process.

![Database Alias definition dialog](image)

**Figure 10** Database Alias definition dialog
8 You will now be able to select this database from the selection window. Select the database and click **OK**. If the ChemStation Security Pack is installed, the selection window offers the additional option of selecting a database for all ChemStation/Data Management Module sessions used on the current work station.

![Database selection screen with Database preselection options (Security Pack only)](image)

**Figure 11** Database selection screen with Database preselection options (Security Pack only)

9 Log-on to this database using the default account name *Admin* with the default password *admin*. Default account information for ChemStore C/S can be found in Chapter 10, “Administration and Reference Information,” starting on page 139.

Once you have successfully logged on, you will need to set up user accounts, studies and custom fields before you can use your database. Refer to the **task help** in the Data Management Module and the ChemStore Concepts Guide for more information on these initial administration tasks.
Installation and Configuration of the Agilent Technologies DB Size Security Service

The Agilent DB Size Security Service is a tool that continuously checks the size of all local databases in use and launches warning and error messages to remind the user to generate a new work database or delete a set of runs after archiving if the database should exceed a specified size.

However, the service works independently, and does not interact with the ChemStore Spooler. It is still possible to continue working and, of course, to spool too many data into the database. A configuration tool allows administrators to set reasonable warning limits and warning repetition intervals.

Installation

1. Browse the G2181 folder of the ChemStore installation CD and open the folder DB_size_security_service. Print the Install.txt and Readme.txt files.
2. Verify that the compatibility requirements as listed in the Readme.txt file are fulfilled.
3. Read the installation verification section of the Readme.txt file and approve the procedure as described in the Readme.txt file.
4. Close down all applications and log-on as Windows administrator. Open the Windows Explorer and run the program SETUP.EXE as administrator. A reboot of the system is not required.
5. Verify the service has been installed correctly by following the instructions in “Update the attachment section of the protocol.” on page 28.
6. Complete the Service Release/Patch Approval Installation Record.
7. Repeat as necessary for additional standalone systems.
8. Attach the Service Release/Patch Approval and Installation Record and a printout of the Install.txt and Readme.txt to this protocol.
9. Update the attachment section of the protocol.
Configuration

1. Log on as a local Windows Administrator.

2. Browse to the Size Security Service Configuration Panel by selecting All Programs > Agilent ChemStation > Configure DB Size Security Service from the Windows Start menu and do a right mouse click.

3. Run the Size Security Configuration panel as administrator

4. Specify output settings, warning limits and database folders and restart the service to apply the changes.

Figure 12  Size Security Service Configuration Panel
Un-install Information

To un-install the Agilent DB Size Security Service, you can use the Programs and Features panel of the Windows Vista operating system.
The client/server version of the ChemStore application is based on an Oracle database. A client/server installation requires more attention to planning and configuration, since correct operation of the system is dependent on many factors.

Typically, a client/server network will consist of the database server, one or more infrastructure servers (domain controllers, print servers, name servers, etc.) and client systems.

The server and all client systems should be networked together using fast ethernet with TCP/IP as the network protocol before installation of the ChemStore client/server software. Since the ChemStore server runs on Oracle, a designated database administrator will be required to maintain the system. The server must have an appropriate back-up device and software, as well as an un-interruptible power supply to allow for proper database shut-down in the event of a power failure.

The clients may be either Agilent ChemStation systems which have the ChemStore Data Management Module application installed or data Data Review systems, which only need the ChemStore Data Management Module application installed. All clients must be configured with a local or network printer.
The client/server system also includes an administration utility called the *Admin Client*. This web-based application is hosted on the server using Microsoft Internet Information Server (IIS) and a Java-based application. The *Admin Client* can be accessed from any computer which has Microsoft Internet Explorer 6.0 SP2 or later installed.

In addition to the *Admin Client* the installation CD offers a small application, called *ChemStore Admin Tools (CAT)*. The Admin Tools offer additional functionality, like archive and delete monitoring, database health reports and advanced troubleshooting capabilities.

Due to the complexity of installing a client/server system, Agilent strongly recommend that a trained consultant be contacted to assist in the planning and implementation of the system. Proper planning is essential to a stable and productive system.
Requirements

The following list shows the minimum requirements for the client in a client/server installation.

**Client Hardware**

- 3.4 GHz - Pentium IV processor
- 4-GB free hard disk space
- 1 GB RAM for single and multi instrument configurations
- Display: 1280 × 1024; small fonts; 65-thousand colors

**Client Software**

The following list shows the minimum software requirements for this application when installed on Windows Vista operating systems:

- Windows Vista Business with Service Pack 1
- Agilent ChemStation revision B.04.01 or later
- Microsoft Internet Explorer 7.0 or later
- A printer must be installed and configured in Windows for correct operation of the ChemStore C/S Data Management Module application.
- During the installation of ChemStore C/S a Microsoft Access 2007 runtime version will be installed. If you have already installed any older Microsoft Office product, there might be a conflict between the Microsoft Access Runtime from ChemStore C/S and the Microsoft Access components installed with Microsoft Office. Limited testing has been performed with MS Access 2003 and no issues have been found. If such a problem exists, you may be asked to remove the Microsoft Access components of Microsoft Office. Other components such as Microsoft Word, Powerpoint and Excel will not conflict with ChemStore C/S.
3 Client/Server Installation

Requirements

- Oracle 10g client for Vista (available from ‘Agilent Technologies Oracle Software for Networked Data Systems’ installation DVD (P/N G4000-60152)
- A printer must be installed and configured in Windows for correct operation of the ChemStore Data Management Module application.

The following list shows the minimum requirements for the server in a client/server installation. See also www.microsoft.com/windowsserver2003/evaluation/sysreqs/default.mspx for the Windows 2003 R2 minimum requirements.

These requirements represent the minimum configuration recommended by Agilent for the small work group database configuration. For larger systems, please contact your Agilent support representative to discuss server requirements.

Server Hardware

- 1.5 GHz Pentium IV processor
- 1 GB RAM
- Hardware RAID SCSI disk controller
  SCSI-2 minimum - with at least 16 MB cache memory.
- 6 Disk Drives - 40 GB or larger
  - 2 drives configured as a mirror set (RAID 1)
  - 4 drives configured as a RAID 5 array, or better a RAID 10 array

This drive configuration yields one mirrored partition for the operating system and application software, and one large array for the database files.

- DAT 40 tape drive, at least
- 1000 VA UPS
Server Software

- Windows 2003 Server R1 or R2 with Service Pack 2
- Microsoft TCP/IP network protocol
- Microsoft Internet Explorer 6.0 SP2 or later (for admin client only)
- Application Server Role for Internet Information Server Version 3
- Mail Server Role (optional, for ChemStore e-Mail notification)
- File Server Role (for SAN support)
- Oracle 10g Standard Server (available from ‘Agilent Technologies Oracle Software for Networked Data Systems’ installation DVD, P/N G4000-60152)

**NOTE**

The US English version of Windows 2003 R2 server received the most test coverage. However no issues were found during tests on localized versions of these operating systems if the regional options were set to English (U.S.).
Planning

The hardware and configuration requirements of your ChemStore server will vary depending on the size of the database you select at installation time and the number of concurrent connections. Active connections include instruments acquiring samples to the database and ChemStore Data Management Modules. This section can help you in the planning and configuration of your database server.

Database Size

The database size that you select at installation time should be given careful consideration as this will affect the total number of runs which can be accessed online and the frequency of archive/de-archive operations. Initial size and extent parameters will also be set based on this choice, so it is important to consider future growth when making this decision.

**NOTE**
Runs which have been archived may only be de-archived (restored) to the same database where the archive was created.

At installation time you may select from the databases configurations shown in Table 3.

<table>
<thead>
<tr>
<th>Database Configuration</th>
<th>Approx. number of runs online</th>
<th>Database Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Small</td>
<td>≤ 7,500</td>
<td>4 GB</td>
</tr>
<tr>
<td>Medium</td>
<td>≤ 25,000</td>
<td>10 GB</td>
</tr>
<tr>
<td>Large</td>
<td>≤ 80,000</td>
<td>40 GB</td>
</tr>
</tbody>
</table>
A run is defined as a single set of results produced from a single sample acquisition or reprocess by a ChemStation which has been transferred and stored into the ChemStore C/S database.

The actual amount of space consumed by each run in a ChemStore C/S database will vary depending on:

- the **Store in Addition to Result** settings of the **Study** to which the run is assigned.
- the technique and the complexity (numbers of peaks, *ChemStation Reports, Custom Fields*, etc.) of your Chromatography for that run.

### Store in Addition Settings of a Study

The **Store in Addition** tab allows you to specify the information that will be stored in the ChemStore C/S database for each run in addition to the result data. [Figure 1](#) on page 18 shows the setting of data storage options within a study.

**Table 4** describes the different information types.

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chromatograms</td>
<td>Stores all available chromatograms (from each detector and/or signal).</td>
</tr>
<tr>
<td>Spectra for quantified peaks</td>
<td>Stores apex spectra from all peaks that have been identified and quantified as compounds in the calibration table.</td>
</tr>
</tbody>
</table>
Agilent ChemStation Techniques

For a list of the Agilent ChemStation revision B.04.01 products that are compatible with ChemStore C/S, see “Standalone Data Management Module” on page 12.

For your reference, Table 5 shows average file sizes by technique. The actual file sizes for the techniques will vary based on the total run time and the complexity of the samples that are analyzed, as well as the spectra storage options and acquisition data rate. You should check the size of your data files during the planning process if you intend to store the raw data on a routine basis in the ChemStore C/S server database, as your typical file sizes may differ significantly compared to the averages shown.

<table>
<thead>
<tr>
<th>Technique</th>
<th>Average File Size (kB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>GC/LC - 2D</td>
<td>50</td>
</tr>
<tr>
<td>LC - 3D</td>
<td>600</td>
</tr>
<tr>
<td>LC/MS – 3D</td>
<td>750</td>
</tr>
<tr>
<td>CE – 3D</td>
<td>600</td>
</tr>
</tbody>
</table>
The amount of result information stored for each peak in the ChemStore C/S database varies on the type of Agilent ChemStation report that was used when the data was transferred and stored in the database.

Typical runs use approximately 10 KB for a short report with 4 peaks, and use up to 300 KB per run for an extended performance report with 20 peaks. Refer to Table 6 for guidance in calculating the amount of database space used.

Table 6  Result Storage Requirements

<table>
<thead>
<tr>
<th>Number of peaks</th>
<th>Agilent ChemStation Report style</th>
<th>Run length (minutes)</th>
<th>Approximate size per run (KB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Short</td>
<td>6</td>
<td>10</td>
</tr>
<tr>
<td>4</td>
<td>Short</td>
<td>30</td>
<td>40</td>
</tr>
<tr>
<td>4</td>
<td>Extended performance</td>
<td>6</td>
<td>80</td>
</tr>
<tr>
<td>20</td>
<td>Short</td>
<td>6</td>
<td>190</td>
</tr>
<tr>
<td>20</td>
<td>Extended performance</td>
<td>6</td>
<td>300</td>
</tr>
</tbody>
</table>

**Server Performance Considerations**

The most important performance factor when configuring the server will be the disk configuration. While memory and processor speed play a role in database performance, the limiting factor is usually disk access. For this reason, Agilent recommends that the database files are stored on a RAID 5 or 10 disk array with a minimum of four spindles (disk drives). During the installation, the ChemStore C/S server software will offer the option to create the database files on either one or multiple disk drives. The multiple drive option should only be chosen when multiple disk arrays are configured on the server. These options should be considered during the planning process, since they will dictate how many drives and disk array controller channels are needed.

Additional disk drive space should be planned for temporary storage of archived data. Also, if down time is a critical issue then a secondary disk array should be configured for use during the backup procedure. This can reduce the down time needed for full database backups.
RAID-5 Disk arrays with fewer spindles offer lower performance than arrays with a greater number of spindles. There is no benefit gained by placing the database files on separate low-performance drives compared to using a single high-performance disk array. Also, no benefit is gained by placing the database files on separate partitions of a single disk or disk array.

The Oracle Server can benefit from multiple processors as well as large amounts of RAM. However, changes must be made to the database configuration before the database application can benefit from these upgrades. Consult your Agilent support representative if you are considering adding additional processors or memory to your system.

**Infrastructure Server Roles**

Database operation is a demanding application for a server. Due to the demands placed on the database server, Agilent recommends that you do not run other server roles on the same system. While the database server can act as a domain controller in a small workgroup, the following server roles should not be run on the database server.

- Print Server
- Name Server (WINS/DNS)
- Proxy Server
- Mail or News Server (with the exception of a virtual Mail server required for the ChemStore e-mail notification)

**Authentication Considerations**

Each client must have read-access to a configuration share on the database server that will be created during installation. Agilent recommends that the clients and server be configured in the same Windows domain, to ensure correct user authentication. It is not recommended for the database server to be a domain controller.
**Network Considerations**

The systems in the client/server installation should be networked together using a modern network architecture for best performance. Agilent recommends using fast ethernet to interconnect the systems and also recommends the use of layer-2 switching (switching hubs) to help manage traffic levels. Due to the real-time nature of data acquisition and the large amount of data produced by chromatographic systems, other activities which produce large amounts of network traffic should be avoided. These include the use of network-based backup solutions and network software deployment solutions. If such solutions are required, then special attention must be given to the network configuration to ensure that the data acquisition and database operations can continue uninterrupted.

**License Considerations**

In addition to the Agilent client software, you should ensure that you have purchased sufficient client access licenses for the Windows Server and Oracle 10g. Consult your Agilent sales representative for clarification on any licensing questions.
Server Installation

The ChemStore C/S server installation package requires you to install the Oracle 10g database management software before it can be started. The ChemStore C/S server installation performs the following tasks:

- Installs ChemStore C/S server software and adds it as a service (ChemStore Archive server).
- Launches the Oracle Net Configuration Assistant so you can create Net Service name.
- Creates the database to which your ChemStore C/S client software can connect.
- Installs the ChemStore C/S Admin Client and associated Java Runtime software.
- Adds ChemStore C/S Admin Client to your Windows Start > Programs menu.
- Creates a share named Config for the global configuration file.
- Creates and modifies configuration files; see “ChemStore C/S Files” on page 169.

Before you install ChemStore Server software you need to know the host name of the ChemStore server (e.g. dbserver) and select a database name that can be up to four letters (e.g. hpcs). The Net Service name needed for the Net Configuration Assistant is composed of the host name and the database name separated by a underline (e.g. dbserver_hpcs).

Install Oracle 10g Database Management Software

If Oracle 10g Database Management software was not on your system prior to ChemStore installation, you must install it from the DVD that came with your ChemStore server software. After the installation of Oracle 10g database management software, you must restart your server before continuing with the installation of the ChemStore server software.
1 Log-on to Windows as a user with administrative capabilities on the intended ChemStore server machine.

2 Verify that the ‘Regional options’ of the operating system are set to ‘English (United States)’. Time, Date and Currency can be customized later on, but the number format must not be changed.

3 Verify the time zone settings and the clock to be set correctly.

4 Put the Oracle 10g installation DVD into the DVD drive on your server and browse to folder 10201_database_win32. Execute setup.exe from the mentioned folder.

CAUTION
Do not install Oracle 10g database management software if another version of Oracle software is already installed. Contact an Agilent support representative to assist you in removing the other version of Oracle software before proceeding.

5 Enter the following information in the Installation Method screen:
   - Choose Basic Installation
   - The Oracle Home location (default is C:\Oracle\product\10.2.0\db_1)
   - Select Standard Edition as the installation type. The Enterprise Edition is not included in the G1410A licence.

The default Oracle Home name should be used, although the installation location may be chosen based on your requirements.

Do not create a starter database unless this is required for Oracle training purposes.
3 Client/Server Installation

Server Installation

6 Click Next.

7 Let the **Product-Specific Prerequisite Checks** complete. Do not continue unless the overall result of this check is passed.
8 Click **Next**.

9 Once all options have been chosen, you will be presented with a **Summary** screen showing your installation choices. If all choices are correct, click the **Install** button to install the software.

10 Verify the **End of Installation** screen reports a successful installation of Oracle Database 10g.

11 Reboot the server.

12 If present: Stop and change the start-up mode to **manual** for the following Oracle Services: **OracleMTSRecoveryService**, **OracleOraHomeHTTPServer**, **OracleOraHomeClientCache**, **OracleOraHomePagingServer** and the **Distributed Transaction Coordinator** service.
Install the Oracle 10g database Patch Set 10.2.0.4.0

Do this step on the Oracle server

1. Stop all the Oracle Services and the **COM+ Event System** service:
   a. Click **Start>Settings>Control Panel>Administrative Tools>Services**
   b. Stop all Oracle services and the **Distributed Transaction Coordinator** service.
   c. Stop the **COM+ Event System** and disable this service. After successful installation of this Oracle patch, the initial startup type need to be activated again.

2. Place the Oracle 10.2.0.4.0 patch installation DVD *(Part #G4000-60153)* into the disk drive.

3. To install the **Oracle Patch Set 10.2.0.4.0**, use the **Oracle Universal Installer** 10.2.0.4.0 from the patch installation DVD:
   a. Click **Start >Run** and run `d:\10204_win32\Disk1\setup.exe` where `d` is the letter of the DVD-ROM drive.
   b. At the **Welcome** screen, click 'About Oracle Universal Installer ...', and verify that the version is 10.2.0.4.0.
   c. Click **OK** and **Next**
   d. On the **Specify Home Details** screen change the destination name selection to **OraDB10g_home1** and the installation path gets automatically updated to `\\oracle\product\10.2.0\db_1`. Click **Next**. Click **Install**.

**NOTE**
The Oracle installer does not recognize the Oracle home directory and it defaults to a new home directory **OraDB10g_home2**. This must be actively changed to the actual home directory before proceeding with the patch installation.
4 When the Summary list is complete, check that **Oracle 10gR2 Patch Set 3 10.2.0.4.0** is displayed.

5 Click **Install**.

**NOTE**

If you get an error message that Oracle services are still running, click **Cancel**. Select **Stop installation of all products** and click **OK**. Click **Exit**, then click **Yes**. Stop all running Oracle services (see step 1 above) and start again at the beginning of step 2.

6 Click **Exit** if you see ‘**The installation of Oracle 10g Release 2 Patch Set 3 was successful**’. Click **Yes** on the question do you really want to exit.

7 Set the **COM+ Event System** service back to it’s initial startup type and reboot the server.
Configuring the TNS Listener Service

ChemStore Server uses Oracle network communications services to access the Oracle database through the Oracle TNS Listener service. During this part of the Oracle 10g database management installation, you will be configuring the TNS Listener Service on the server.

1. Select Programs > Oracle - OraDb10g_home1 > Configuration and Migration Tools > Net Configuration Assistant from the Windows Start menu.

2. Select Listener Configuration from the Net Configuration Assistant welcome screen and then click Next.

![Oracle Net Configuration Assistant: Welcome screen](image)

**Figure 17** Oracle Net Configuration Assistant: Welcome screen

3. In the Listener Configuration screen select Add and press Next.

4. Specify a listener service name or just simply keep the default name Listener. Press Next.
5 The installation program prompts you to choose a protocol type in the next screen. Choose TCP and then click Next.
In the next screen, enter the host name of your database server and then click **Next**. The standard port number of **1521** is recommended. Press **Next**.

![Listener configuration, port number selection](image)

**Figure 20** Listener configuration, port number selection

In the **More Listeners?** screen select **No** to exit the listener configuration. Press **Next** to continue.

In the **Listener Configuration** screen press **Cancel** to return back to **Oracle Net Configuration Assistant**. You may **Cancel** this screen or continue with the Net service Name Configuration described in the following section.

### Configuring the Net Service Name

ChemStore Server uses Oracle network communications services to access the Oracle database through the Oracle TNS Listener service. During this part of the Oracle 10g database installation, you will be configuring the **Net Service name** for local access to the database.

In order to correctly configure the Net Service name, you will need to know the host name of the database server and the four-character database name. The Net Service name must be in the format of the host name and the database name separated by a underscore (e.g. `dbserver_hpcs`).
1. Select **Programs > Oracle - OraDb10g_home1 > Configuration and Migration Tools > Net Configuration Assistant** from the Windows **Start** menu.

2. Select **Local Net Service Name configuration** from the **Net Configuration Assistant** welcome screen and then click **Next**.

**Figure 21**  Oracle Net Configuration Assistant: Welcome screen

**Figure 22**  Net Service Name Configuration
3 Enter the database name (for example hpcs) in the service name field and click Next.

![Net Service Name Configuration Service Name](image1)

**Figure 23** Net Service Name Configuration Service Name

4 The installation program prompts you to choose a protocol type in the next screen. Choose TCP and then click Next.

![Protocol selection](image2)

**Figure 24** Protocol selection
5 In the next screen, enter the host name of your database server and then click Next. The standard port number of 1521 is recommended.

![](image)

**Figure 25**  Host name setting

6 Do not choose the option to test the name service when offered. The test would fail at this point in the configuration. Select Next to continue.

7 Enter a **Net Service Name** consisting of the host name of your server and the database name separated by an underscore character (for example csserver_hpcs).

![](image)

**Figure 26**  Net Service Name Configuration Net Service Name
3 Client/Server Installation
Server Installation

This format is critical to the installation of the ChemStore server software, and you will not be able to create the database unless the **Net Service name** is in the correct format.

8 Select **No** when offered the option to configure another Net Service name. Then click **Next** to continue.

9 A confirmation screen is presented to notify you that the Net Service name was created successfully. Click **Next** to continue.

10 You will be presented with the **Net Configuration Assistant** main screen after configuring the Net Service name. Click **Finish** to exit the **Net Configuration Assistant** utility.
Testing Net Communications

Perform the following steps to verify that the Net Service name is correctly configured and can communicate with the TNS Listener service. It is important to perform this test before continuing with the installation as an error in the Net communications will cause the database creation to fail.

1. Check that the Listener e.g. **OracleOraDb10g_home1 TNSListener** service is running.

2. To verify that the Net Service name was created correctly, open a **Command Prompt** window on your server and type the following command:

   ```
   TNSPing <Net Service name> (e.g. TNSPing cserver_hpcs)
   ```

3. The **TNS Listener service** should respond correctly as shown in the following figure.

   ![Figure 27: TNSpinging the Oracle listener](image)

4. If you do not get the expected response as shown, refer to Chapter 7, “Troubleshooting Tips,” starting on page 113 to identify and correct the communications problem before continuing with the installation.
Install ChemStore C/S Server Software

1. After installing the Oracle 10g database software, you must shut down and restart your system before proceeding with the ChemStore C/S server installation.

2. Make sure you have installed Internet Information Server (IIS) and that you have satisfied the other requirements described in “Requirements” on page 33 and “Planning” on page 36.

3. Log-on to your server as a user with administrative capabilities.

4. Verify that the currently logged on user is a member of the user group ORA_DBA. This is mandatory for a successful database generation.

5. Put the ChemStation Plus Installation CD into the CD-ROM drive on your server machine, select Start > Run and run \G1410A\setup.exe from the CD-ROM drive.

6. Click Next when the installation program displays a Welcome dialog box.

7. After accepting the Agilent Software License Agreement, you will be prompted for your software license/registration number. This number can be found on the yellow license packet that came with your software. Enter the number and click Next to continue.
8 The installation program displays the **Choose Destination Location** dialog box.

   a  Click **Next** to accept the default location (C:\hpchem).

   b  Click **Browse** if you wish to specify that the ChemStore C/S server application files be installed in a different location.

**NOTE**
The path name of the new location must not contain blank characters.

![Choose Destination Location](image)

**Figure 28**  ChemStore server installation screen

If the directory you specify (or the default directory) does not exist, the installation program prompts you to create the directory.
When you see the **Installation Components** dialog box, make sure both check boxes are selected:

- **ChemStore C/S - Server** installs the ChemStore C/S server software onto your system.
- **Configure Oracle Server** automatically creates the ChemStore C/S database.

![ChemStore C/S - Server Installation Components](image)

**Figure 29** ChemStore server and database creation options

**NOTE**

For systems which will require advanced customization of the database, de-select the option to configure the Oracle Server. The installation scripts may then be modified. The server software set-up is then repeated with only this option selected to create the customized database. This procedure should only be performed by trained Agilent consultants.
10 In the confirmation dialog box, check the information displayed. Click Back to change any of the information, or click Next if this dialog box displays the correct information.

![Installation summary screen](image)

**Figure 30** Installation summary screen

The installation program starts installing the ChemStore C/S server.
Create the Oracle Database

After installing the software, the system prompts you for more information in order to create the database.

1. Enter the database name of four characters or less (the default name is hpcs).

**CAUTION** The database name is case-sensitive. It is the name that you will use to connect to your Data Management Module. Make a note of it as you will need it when setting up the ChemStore Data Management Module.
2 Choose the option **Small, Medium, or Large** for your database size, using the guidelines described in “Planning” on page 36.

![Select database size](image)

**Figure 32** Select database size

3 Choose single disk drive; or choose multiple disk drives for better performance provided that you have configured your disk arrays with this option in mind.

---

**CAUTION**

It is important that you specify all of this information correctly to ensure a proper configuration of the Oracle database.
If you chose to store files on multiple disk drives, you will be presented with another dialog where you specify the distribution of database files:

- In each dialog box, specify only the destination disk drive; do not specify a path.

  If you enter a path, the set-up program ignores the path but uses the specified drive. The ChemStore system stores all database files in the `dbs\database_name` directory of whatever drive you specify; for example, `\dbs\hpcs`. For example, if you specified `e:\csdata` for the location of your data files, the system stores the files on the `E drive` as you specified, but in the `\dbs\database_name` directory.

- You should specify a different disk drive for each data file type, and make sure you have the required amount of disk space, as indicated in each dialog box.

**Figure 33** Choose destination location for Oracle database files
For maximum performance, Oracle recommends that the following files are located on separate disk arrays: data file, index files, undo files, and log files. For improved performance, avoid putting your data and undo files on the same drive. For example, you might want to configure your system as follows:

<table>
<thead>
<tr>
<th>Disk Drive</th>
<th>Data File Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>D:\</td>
<td>Data files</td>
</tr>
<tr>
<td>E:\</td>
<td>Index files</td>
</tr>
<tr>
<td>F:\</td>
<td>Undo files</td>
</tr>
<tr>
<td>G:\</td>
<td>System files, log files</td>
</tr>
</tbody>
</table>
4 The installation program displays the **Oracle Configuration Summary** screen. If you specified storage to multiple disks in step 3, scroll down to see your disk configuration and review the information.

![Oracle Configuration Summary](image)

**Figure 34** Oracle Configuration Summary

**CAUTION**

You must make certain that you have sufficient disk space for ChemStore C/S files on every disk drive that you allocated. This confirmation dialog box tells you how much space you have allocated on each drive for ChemStore C/S and its related Oracle files; you should ensure that the disk drives can accommodate these allocations.

If you have not created the Net Service name at this point, the **Net Configuration Assistant** will be started automatically to allow you to perform this task. Refer to “Configuring the Net Service Name” on page 50 for instructions on creating the Net Service name.
The installation program creates the database, a configuration share named \texttt{config}, the global configuration file \texttt{hpdbglob.cfg}, the ChemStore C/S Archive Server service, and other files necessary for running ChemStore C/S.

**NOTE**

With the standard small database installed on the recommended minimum hardware configuration, the database creation process may take up to 45 minutes to complete.

**CAUTION**

If the database creation takes longer than one hour to complete (or two hours for the large database configuration), you should review your configuration choices and either choose a smaller database size or upgrade your server hardware configuration. Poor performance during the installation is a warning indicator that your system will not produce acceptable operational performance.

5. Click \textbf{Finish} at the end of the installation.
6. Restart your server after installing the ChemStore C/S Server software to initialize the software settings and test the proper startup of the ChemStore C/S Archive Server service.

**Completing the Installation**

After the installation, you will need to perform the following important administrative tasks.

- Install Oracle critical patch updates (see next section)
- Enter a database description to identify the database to clients.
- Change the default database passwords.
- Prepare and test a database back-up strategy
- Test your power fail protection (UPS)

Instructions for these administrative tasks can be found in Chapter 10, “Administration and Reference Information,” starting on page 139.
Install Oracle 10g database Critical Patch Updates (optional)

Install the Oracle 10g database critical patch updates (CPU) from your Oracle 10g installation DVD (patches). These CPUs are published on a quarterly basis. To get latest hot fix information consult the Oracle metalink support page:

www.oracle.com/support/premier/global-support-resolution/metalink.html

or check out the ChemStore specific compatibility information on:

If you have an active ChemStore server maintenance agreement these hot fixes can be requested from Agilent. Please contact your local support provider.

For patch installation you must use the OPatch utility release 10.2.0.3.4 from your Oracle 10g installation DVD (Patches\Opatch_10.2.0.3.4). Newer hot fixes may require a higher version of this utility.

**NOTE**

The Oracle hot fix can only be applied to existing database instances. New database instances need to be upgraded as well. For good updating performance it is strongly recommended to turn the archive-log mode off, if applicable.

Please refer to the Oracle Patch installation documentation (readme.html) for patch specific installation instructions. The Oracle CPU installations include an Oracle migration to the new patch level and should only be executed by an Oracle DBA or a trained Agilent consultant.
Client Installation

The installation for the client/server version of the ChemStore C/S Data Management Module performs the same tasks as the standalone version, but adds the ChemStore Admin Client to your Windows Start > All Programs menu and the connectivity software to allow the client to connect to the ChemStore server database. Before you start the installation of the ChemStore Data Management Module, you will need to install the Oracle 10g Client software plus the indicated Oracle patches.

Install Oracle 10g Client Software on Windows Vista

If you plan to use your ChemStore client to connect to a ChemStore server, you must install the Oracle 10g client for Vista software from the Oracle 10g installation DVDs that were shipped with your ChemStore Server Software. Once you have installed the Oracle 10g Client software, you must restart your system. Then you can proceed with the installation of the ChemStore Data Management Module software.

The Oracle Client software uses approximately 200 MB of disk space.

1. Log-on to Windows Vista as a user with local administrative capabilities.

   You must log on as a user with capabilities that allow a connection to the server where the ChemStore C/S server and Oracle database reside. The user will need read-access to the Config share on the server created by the ChemStore C/S server installation.

2. Put the Oracle 10g installation DVD into the disk drive on your client computer. Browse to \10203_client_vista\ and execute setup.exe.
3 Click on the **Installed Products** button on the **Welcome** screen to detect if any existing Oracle products are installed. If no Oracle products are displayed in the inventory window, close the inventory window and select **Next** to continue with the installation.

**NOTE**

Do not install Oracle 10g client software if another version of Oracle software is already installed. Contact an Agilent support representative to assist you in removing the other version of Oracle software before proceeding.

4 When prompted to choose the installation type, select the option **Custom**. This will allow you to install the minimum configuration required by the ChemStore C/S Data Management Module application.

![Oracle Universal Installer: Installation Types](image)

**Figure 35** Oracle Universal Installer: Installation Types

5 Click **Next**.

6 Enter the following information in the **Specify Home Details** screen:
   a The Oracle Home name (default is OraClient10g_home1)
b The Oracle Home location (default is C:\Oracle\product\10.2.0\client_1)

7. Click Next.

8. In the Available Product Components screen browse to the Oracle Windows Interfaces 10.2.0.1.0 and select this node.

9. The subsequent node gets activated and then de-select all activated subitems with the exception of the Oracle Objects for OLE 10.2.0.3.0, Oracle ODBC driver 10.2.0.3.0, Oracle Provider for OLE DB 10.2.0.3.0, and Oracle Data Provider for .Net 10.2.0.3.0.
10 Minimize the **Oracle Windows Interfaces 10.2.0.1.0** node and scroll down and select the **Enterprise Manager 10g Java Console 10.2.0.3.0** node.

![Available Product Components](image)

**Figure 37** Oracle Universal Installer: Available Product Components

11 Click **Next**.

12 The **Product Specific Prerequisite check** gets executed and you should not proceed with the installation unless this test has passed successfully.

13 The **Summary** screen will be displayed and will show the installation options chosen as well as locations and disk space usage requirements.

14 Click **Install** to proceed with the installation of the Oracle 10g client software.

Once the installation comes to an end, the installer will display a configuration tools screen and automatically run the **Net Configuration Assistant**. **Do not skip** this step at this point as the Oracle Net configuration is completed quickly and skipping this step would start a cascade of warnings.

15 In the **Net Configuration Assistant Welcome** screen select **Perform typical configuration** and press 2 times **Next** and the installation completes. However, the specific **Net Service Name** configuration still needs to be done after applying the Oracle Patch set 10.2.0.4.0.
16 On the **End of Installation** panel click **Exit**

---

**Figure 38** Oracle Net Configuration Assistant: Welcome screen

---

**Install the Oracle 10g Client Patch Set 10.2.0.4.0**

Do this step on the Oracle client

1. Stop all the Oracle Services and the **COM+ Event System** service:
   
   a. Click **Start>Settings>Control Panel>Administrative Tools>Services**
   
   b. Stop all Oracle services and the **Distributed Transaction Coordinator** service.
   
   c. Stop the **COM+ Event System** and disable this service. After successful installation of this Oracle patch, the initial startup type need to be activated again.

2. Place the Oracle 10.2.0.4.0 patch installation DVD (**Part #G4000-60153**), into the disk drive.

3. To install the **Oracle Patch Set 10.2.0.4.0**, use the **Oracle Universal Installer 10.2.0.4.0** from the patch installation CD:
   
   a. Click **Start>Run** and run `d:\10204_win32\Disk1\setup.exe` where d is the letter of the CD-ROM drive.
   
   b. At the **Welcome** screen, click **'About Oracle Universal Installer ...'**, and verify that the version is **10.2.0.4.0**.
   
   c. Click **OK** and **Next**
3 Client/Server Installation
Client Installation

d Important: On the Specify Home Details screen under Destination change the name selection actively to OraClient10g_home1 and the installation path gets automatically updated to \oracle\product\10.2.0\client_1.

e Click Next.

![File Locations screen of Oracle installer 10.2.0.4.0](image)

Figure 39   File Locations screen of Oracle installer 10.2.0.4.0

4 When the Summary list is complete, check that Oracle 10g Release 2 Patch Set 3 10.2.0.4.0 is displayed.

5 Click Install.

NOTE

If you get an error message that Oracle services are still running, click Cancel. Select Stop installation of all products and click OK. Click Exit, then click Yes. Stop all running Oracle services (see step 1 above) and start again at the beginning of step 2.

6 Click Exit if you see ‘The installation of Oracle 10g Release 2 Patch Set 3 was successful’. Click Yes on the question do you really want to exit.

Set the COM+ Event System service back to it’s initial startup type and reboot the client.
Running the Net Configuration Assistant

Continue with these steps to configure a local Net Service name.

1. Select Programs > Oracle - OraClient10g_home1 > Configuration and Migration Tools > Net Configuration Assistant from the Windows Start menu.

2. Select option to create a local Net Service Name. Directory services are not used for this application.

3. Click Next to continue with the configuration of the local net service name. Continue with the same steps as for the server installation described in section “Configuring the Net Service Name” on page 50.
3 Client/Server Installation

Client Installation

Testing Net Communications

Perform the following steps to verify that the Net Service name is correctly configured and can communicate with the TNS Listener service on the server. It is easier to troubleshoot Net communications problems at this point rather than after the client installation.

1. To verify that the Net Service name was created correctly, open a Command Prompt window on your server and type the following command:

   TNSPing <Net Service name> (e.g. TNSPing dbserver_hpcs)

2. The TNS Listener service should respond correctly as shown in the following figure.

   ![Figure 40 TNSpinging the Oracle listener](image)

3. If you do not get the expected response as shown, refer to Chapter 7, “Troubleshooting Tips,” starting on page 113 to identify and correct the communications problem before continuing with the client installation.
Installing ChemStore Data Management Module

Before installing the ChemStore Data Management Module, you will need to obtain the host name of the database server and the ChemStore database name from the administrator of the server system.

Perform the following steps to install the ChemStore Data Management Module and configure it to connect to your database server.

1. Make sure the ChemStore server is running.
2. Log-on to Windows as a user with administrative capabilities.
3. Verify that the ‘Control Panel > Regional and Language options > Formats’ of the operating system are set to ‘English (United States)’. Time, Date and Currency can be customized later on, but the number format must not be changed.
4. Verify the time zone settings and the clock to be set correctly. It is not recommended to keep the automated clock adjustment for daylight saving changes. The clock adjustment should be done manually at a dedicated time when all ChemStation applications are closed. These settings can be adjusted under Date and Time > Change Time Zone. Synchronization with the Windows internet time server need to be turned off, too.
5. Put the ChemStation Plus Client installation CD into the CD-ROM drive on your computer, open the Windows explorer and browse to the file \G2181\Setup.exe on the CD-ROM drive.
6. Right click the file setup.exe and run it as administrator.

The ChemStore set-up program will start and after confirming the Vista User Account Control dialog the program will lead you through a number of installation screens. Select Next at the information screen to proceed with the installation.

7. After accepting the Agilent Software License Agreement, you will be prompted for your software license/registration number. This number can be found on the yellow license packet that came with your software. Enter the number and click on the button Next to continue.

8. Enter the path to install the ChemStore C/S software. By default the software is installed in a subdirectory under the ChemStation directory (\chem32). If the installation is supposed to be extended by ChemStation Plus Security Pack, the installation path must not be different to the ChemStation installation path. Further on, the installation path must not contain blanks. You can configure the software to store the database in a
3 Client/Server Installation

Client Installation

separate location, such as on another local disk partition if you wish regardless of the location of the client software.

9 Click the button **Next**.

![Figure 41 Choose Destination Location](image1)

10 Select both **ChemStore - Client** and **Client/Server Connection** when prompted.

![Figure 42 ChemStore Data Management Module Installation Components](image2)
11 When the **Confirmation** screen appears, check the information on the dialog box.

12 Click **Next** if this dialog box displays the correct information, or click **Back** to change any of this information.

![Start Copying Files](image)

**Figure 43** Installation Summary Screen

The installation program installs the ChemStore Data Management Module software.

13 When the **Oracle Server Information** dialog box appears, enter the server’s host name and the database name (the default is `hpcs`).

**CAUTION**

The database name is case-sensitive. It is the name that you used to name the database when you created the database on the server.
3 Client/Server Installation
Client Installation

14 Click **Next**.

15 When the confirmation screen appears, check the information on the dialog box. Click **Next** if this dialog box displays the correct information, or click **Back** to change any of this information.
This dialog box also tells you whether or not you need to run the **Net Configuration Assistant**. If you followed the steps to create the Net Service name during the installation of the Oracle clients software, you will not need to perform these steps again. If a local Net Service name does not exist, you will be prompted to create one.

The ChemStore C/S installation program configures the ODBC drivers and prompts you to restart the system.
3 Client/Server Installation
Client Installation

Connecting to the Database

Once you have installed the ChemStore Data Management Module you need to restart your system before you can start the Data Management Module software.

1 Log-on as a Windows administrator
2 From the Windows Start menu, select All Programs > Agilent ChemStation > ChemStore Review Client and run it as administrator
3 Confirm the Vista User Account Control message
4 At the ChemStore Log-on screen, press the Select button to see the list of available databases.
5 You should see the four-character database name of the server database as well as the description of the server database in the list.
6 If you receive an error about accessing the global configuration file, refer to Chapter 7, “Troubleshooting Tips,” starting on page 113 to resolve the access problem.
7 Select the server database and click OK.

NOTE

When the ChemStation Security Pack is installed, a user with administrator permissions must preselect this database for operating system users, since these users do not have the permission to select or change the database.

Figure 46 ChemStore Database selection screen with Database preselection options (Security Pack only)
8 Log-on using the default administrator account **Admin** with a password of **admin**. If you can log into the database then the installation of the client access software and Data Management Module were successful.

![ChemStore C/S Log on panel](image)

**Figure 47**  ChemStore C/S Log on panel

9 If you are not successful, then test the ODBC configuration and connection as described in Chapter 7, “Troubleshooting Tips,” starting on page 113.

**Completing the Installation**

After the installation, you may wish to perform the following important administrative tasks.

- Install any additional ChemStation Plus software such as the ChemStation Plus Security Pack or the ChemStore Admin Tools.
- Prepare and test a client backup strategy
3 Client/Server Installation

Client Installation
The information in this chapter only applies if you already have a standalone ChemStore C/S installation B.04.02 or higher and wish to use the standalone client in a client/server configuration.
Before you perform these steps, you will first need to purchase and install a new ChemStore C/S Database Server. Read the section “Requirements” on page 33 to learn about the server and client requirements.

Follow the instructions in Chapter 3, “Client/Server Installation,” starting on page 31 to install and configure your server.

The Data Management Module upgrade is typically a three-step process:

- Installing the ChemStore C/S client connectivity software, which includes:
  - Installing the Oracle 10g client software plus Oracle patches
  - Upgrading the ChemStore C/S client software
- Connecting to the server database
- Migrating the standalone databases to the server.
Installing the Client/Server Connectivity Software

The update of the ChemStore C/S Data Management Module requires that Oracle 10g Client software be installed. The Oracle client software was shipped with your ChemStore C/S Server software.

Installing Oracle 10g Client Software

If you plan to use your ChemStore C/S client to connect to a ChemStore server, you must install the Oracle 10g client software from the Oracle 10g client CD that shipped with your ChemStore Software.

The installation is divided into the following steps:

1. The installation of the Oracle 10g client software needs to be performed according to the sections “Install Oracle 10g Client Software on Windows Vista” on page 67
2. Installation of Oracle patches as described in “Install the Oracle 10g Client Patch Set 10.2.0.4.0” on page 71
3. Configuration of the Net Service Name as described in “Configuring the Net Service Name” on page 50
4. Testing of the Net Communication as described in section “Testing Net Communications” on page 55

If all those steps are completed successfully, you can proceed with the upgrade of the ChemStore Data Management Module software.
Upgrading the ChemStore C/S Client Software

Before upgrading the ChemStore Data Management Module, you will need to note the host name of the database server and the ChemStore database name from the administrator of the server system. These are the names you used in the configuration of the Net Service name. You will also need the license registration number for your Data Management Module. This number can be found in the csClient.log file in the \chem32\chemstor\install directory on your client computer.

Perform the following steps to upgrade the ChemStore Data Management Module for connection to your database server.

1. Log-on to Windows as a user with administrative capabilities.

2. Make sure the ChemStore server is running, and that the ChemStation and ChemStore Data Management Module applications are not running on your client.

3. Put the ChemStation Plus Client installation CD into the CD-ROM drive on your computer, open the Windows explorer and browse to the file \G2181\Setup.exe on the CD-ROM drive.

4. Right click the file setup.exe and run it as administrator.

5. The ChemStore set-up program will start and after confirming the Vista User Account Control dialog the program will lead you through a number of installation screens. Select Next at the information screen to proceed with the installation.

6. After accepting the Agilent Software License Agreement, you will be prompted for your software license/registration number. This number can be found on the yellow license packet that came with your software. Enter the number and click on the button Next to continue.

7. The set-up routine will automatically locate the path for the Data Management Module software based on the existing installation. This path must not be changed. Select Next to continue.
8 Deselect the **ChemStore - Client** and select the **Client/Server Connection** when prompted as shown in the following figure.

![ChemStore Data Management Module Installation Components](image)

**Figure 48**  ChemStore Data Management Module Installation Components

9 When the **Confirmation** screen appears, check the information on the dialog box.

10 Click **Next** if this dialog box displays the correct information, or click **Back** to change any of this information. The installation program upgrades the ChemStore Data Management Module software with the missing client/server components.

11 When the **Oracle Server Information** dialog box appears, enter the server’s host name and the database name (the default is `hpcs`).

**CAUTION**

The database name is case-sensitive. It is the name that you used to name the database when you created the database on the server.
4 Upgrading ChemStore Standalone to Client/Server

Installing the Client/Server Connectivity Software

12 Click Next.

13 When the Confirmation screen appears, check the information on the dialog box. Click Next if this dialog box displays the correct information, or click Back to change any of this information.

Figure 49  Enter Oracle Server Information

Figure 50  Oracle Configuration Summary
This dialog box also tells you whether or not you need to run the Net Configuration Assistant. If you followed the steps to create the Net Service name during the installation of the Oracle clients software, you will not need to perform these steps again. If a local Net Service name does not exist, you will be prompted to create one.

The ChemStore C/S installation program now configures the ODBC drivers and then prompts you to restart the system.

**Completing the Installation**

After the installation, you may wish to perform the following important administrative task.

- Install the ChemStore Admin Tools on a few dedicated clients.

The installation package and installation description is located in the support folder of the ChemStation Plus installation CD.
Connecting to the Server Database

Once you have installed the ChemStore Data Management Module you need to restart your system before you can start the Data Management Module software.

1 Log-on as a Windows administrator
2 From the Windows Start menu, select All Programs > Agilent ChemStation > ChemStore Review Client and run it as administrator
3 Confirm the Vista User Account Control message
4 At the ChemStore Log-on screen, press the Select button to see the list of available databases.
5 You should see the four-character database name of the server database as well as the description of the server database in the list.
6 If you receive an error about accessing the global configuration file, refer to Chapter 7, “Troubleshooting Tips,” starting on page 113 to resolve the access problem.
7 Select the server database and click **OK**.

**NOTE**

When the ChemStation Security Pack is installed, a user with *administrator* permissions must preselect this database for operating system users, since these users do not have the permission to select or change the database.

---

**Figure 51**  
ChemStore Database selection screen with Database preselection options  
(Security Pack only)

---

8 Log-on using the default administrator account **Admin** with a password of **admin**. If you can log into the database then the installation of the client access software and Data Management Module were successful.

---

**Figure 52**  
ChemStore C/S Log on panel
4  Upgrading ChemStore Standalone to Client/Server
Connecting to the Server Database

9 If you are not successful, then test the ODBC configuration and connection as described in Chapter 7, “Troubleshooting Tips,” starting on page 113.
Migrating Standalone Databases to the Server

ChemStore standalone databases may be migrated to a server database. This allows for a migration path for laboratories that wish to start with small implementations and later move to larger client/server systems. The migration ports the users as well as data, studies and custom field definitions. However, queries, filters, UI settings and report templates are not migrated in order to avoid potential permission conflicts.

When migrating several standalone databases the custom field definitions and study assignments have to be identical on all standalone databases. This is the case if all standalone databases had been derived from one database template and the custom field definitions were not changed after.

After a standalone database has been migrated, it is marked as read-only and may no longer be used by the ChemStore Data Management Module to make changes. **It is strongly recommended that a backup be made of both the standalone and server database before attempting any migration.**

During the process of migration the destination database on the server must be in idle state. Other clients must not spool data at the same time. In addition you need to ensure that all users in the source and destination database are activated and have a password assigned. Further on, all studies need to be in activated status.

Please note that migration is a very resource intensive task and might take up to several hours for completion. As a general rule the migration takes approximately 30 seconds per run.

The task of migrating standalone databases to a server database is performed using the ChemStore Utility using the following steps.

1. You must first have a client/server version of the ChemStore Data Management Module running on your client system and must have access to the server database.

2. In order to migrate a standalone database to Oracle, it must first be in the B.04.02 or higher format. Perform the database schema migration on your
4 Upgrading ChemStore Standalone to Client/Server
Migrating Standalone Databases to the Server

standalone database using the ChemStore Utility before attempting to migrate the database to Oracle.

3 Always ensure that the database you are migrating from is not write protected, as MS Access requires read/write permission on the originating database.

4 Start the ChemStore Utility on your client system by right-clicking All Programs > Agilent ChemStation > ChemStore Utility from the Windows Start menu. The program needs to be run as administrator.

5 At the Windows Vista User Account control panel enter the administrator’s password or simply allow the access.

6 From the ChemStore Utility menus, select Migrate > ChemStore B.04.0x (Stand-alone) ChemStore Server Database.

7 Select the local standalone database that you wish to migrate and click OK.

8 You will be prompted to log-on to the local database. You must log-on using a ChemStore administrator account.
9 You will then be prompted to select the server database to migrate the data to. Select the database from the list and click **OK**.

![Select destination server database](image)

**Figure 54** Select destination server database

10 You will also need to log-on to the server database as a ChemStore administrator. Once you log-on, the migration process starts.

11 During the migration, accounts that are found to have the same name will cause the system to prompt you for action. You may either cancel the migration, rename the local account so that it has a new name on the server database or use the same name; in which case the two accounts are treated as one.
The database migration can take a long time. Plan for at least 30 seconds for each run stored in the local database. A progress bar will be displayed during the migration.

If you stop the migration while it is in progress, you will be able to restart it at a later time. The migration will continue at the point that it was stopped before.
The utility will notify you when the migration is complete.

Details of the migration process can be found in the migration log file `hpax2or.log`, which can be found in the `\chem32\chemstor\work subdirectory` on the client.
4 Upgrading ChemStore Standalone to Client/Server
Migrating Standalone Databases to the Server
The information in this chapter only applies if you already have a standalone ChemStore C/S and wish to upgrade it to revision B.04.02. Instructions for upgrading client/server systems are located in Chapter 6, “Upgrading Client/Server Installations”.
To support the new 1200 LC hardware instruments introduced with ChemStation Revision B.03 and B.04, the database schema for ChemStore rev. B.04.02 is different than the schema for previous revisions. As part of the upgrade process, your database files will need to be migrated to the new schema. Note that once a database has been migrated to the new schema it cannot be used with the previous version of ChemStore software.

Other new and enhanced features in ChemStore revision B.04.0x include

- Support for MS Office 2007
- Support for Microsoft Vista
- Support for Oracle 10g
- Enhanced zooming and display of chromatograms

Please refer to the readme file and software status bulletin (SSB) which are found on the software CD-ROM for changes and a detailed list of defect fixes.
Requirements

The minimum hardware requirements for ChemStore C/S Revision B.04.02 installed on Windows Vista are significantly different than from B.04.01 or previous revisions. You should check your client system against the following lists to determine whether you need to upgrade your client PC’s hardware or operating system.

The following list shows the minimum hardware requirements for this application used in combination with ChemStation rev. B.04.01:

- 3.4 GHz - Pentium IV processor
- 4-GB free hard disk space
- 1 GB RAM for single and multi instrument configurations
- Display: 1280 × 1024; small fonts; 65-thousand colors

The following list shows the minimum software requirements for this application when installed on Windows Vista operating systems:

- Windows Vista Business with Service Pack 1
- Agilent ChemStation revision B.04.01 or later
- Microsoft Internet Explorer 7.0 or later
- A printer must be installed and configured in Windows for correct operation of the ChemStore C/S Data Management Module application.
- During the installation of ChemStore C/S a Microsoft Access 2007 runtime version will be installed. If you have already installed any older Microsoft Office product, there might be a conflict between the Microsoft Access Runtime from ChemStore C/S and the Microsoft Access components installed with Microsoft Office. Limited testing has been performed with MS Access 2003 and no issues have been found. If such a problem exists, you may be asked to remove the Microsoft Access components of Microsoft Office. Other components such as Microsoft Word, Powerpoint and Excel will not conflict with ChemStore C/S.
### Preparation

The upgrade of the ChemStore Data Management Module requires that you first un-install the previous version and than install the new version. During this process, your standalone databases will not be deleted. However, if you have modified the tutorial database (ChemStoreDemo.mdb), please be aware that this file will be overwritten by the new installation. In all cases, a system and database backup should be performed before upgrading the software.

1. Make a backup copy of your database *.MDB files. By default your databases are located in `chem32\chemstor\database`. Make a back-up copy of your ChemStation methods, sequences and data files.

2. Note your current ChemStore licence number, as you will need it for the new installation.

Your licence number was included with the software certificate and registration packet for your existing revision of software. It is your proof of purchase and should always be available for inspection.

If you do not have the original registration packet available, the licence number can be found in the file `chem32\chemstore\install\csClient.log` in the section “Components Selected”.

Uninstallation and new installation

Uninstall the Previous ChemStore Software

For all ChemStore upgrades, follow the directions below.

Uninstall any previous ChemStore software according to “De-installing the ChemStore Client Software” on page 126.

NOTE
If you have Agilent Technologies DB Size Security Service installed, remove the DB Size Security Service software before uninstalling the ChemStore Data Management Module.

Install the New Software Revision

The Data Management Module installation performed during an upgrade is identical to a new standalone ChemStore installation. Follow the steps outlined in chapter “Installation Procedure” on page 20.
Migrate Your Databases

Since the B.04.02 or higher ChemStore database has a different schema than previous revisions, it is necessary to migrate any standalone databases you may have to the new schema before you can open them with the new revision of the Data Management Module.

Once a database has been migrated to B.04.02 or higher, it cannot be opened using previous revisions of ChemStore. Always perform a database backup before attempting any migration task.

Databases in the single-file format for ChemStore can be migrated to the B.04.02 schema quickly. The database is opened using the ChemStore Utility and is converted by this utility through internal modifications to the appropriate tables.

Follow these steps to migrate a ChemStore database in the B.01.0x, B.02.0x or B.03.0x format to the new B.04.02 or higher revision.

1 Log onto Windows as a user with administrative capabilities.
2 Select ChemStore Utility from the Windows Start > All Programs > Agilent ChemStation menu.
3 Confirm the Vista User Account Control notification with Allow.
4 From the Migrate menu, select ChemStore B.0x.0x to B.04.02 (Stand-alone) Database.
5 Select the standalone database that you wish to convert from the file selection dialog. A message box will be displayed when the migration is complete.

Figure 58 Chemstore C/S Database Migration confirmation
Connecting to the Database

Log on to the migrated database using your administrator account. The log-on process is described in section “Connecting to the Database” on page 24. The ChemStore B.04.02 Data Management Module will only be able to connect to the database if it was successfully converted to the B.04.02 schema.
5 Upgrading Standalone Installations
Migrate Your Databases
The information in this chapter applies only if you already have a client/server ChemStore installation revision B.01.0x, B.02.0x or B.03.0x available.

**CAUTION**

The upgrade process for a client/server system is quite complex and involves a certain amount of laboratory down-time. Due to the complexity of this job, Agilent recommend that customers do not attempt to upgrade client/server systems without the assistance of trained Agilent consultants or engineers.

The documentation in this section only gives an overview of the upgrade process to assist you in planning such an upgrade. Detailed instructions are not feasible due to the wide variation in installation options and the number of possible upgrade scenarios. Contact your Agilent support representative for assistance in planning and implementing your client/server upgrade.
The migration of a ChemStore server may include up to eight general parts:

1. Server hardware upgrade
2. Client hardware upgrade
3. Upgrading the server operating system
4. Upgrading the clients operating system
5. Upgrading the Oracle platform on server and clients
6. Upgrading ChemStore server software
7. Migrating the ChemStore database schema (server only)

Depending on the starting conditions, steps 1-4 might not be needed but steps 5 - 8 are always mandatory when upgrading to rev. B.04.0x.

The minimum hardware requirements for ChemStore clients as well as servers of revision B.03.02 or higher are significantly different than previous revisions. Upgrading from revision B.03.02 or B.03.03 may not require any new hardware. You should check your client/server system against the requirements listed on page 33 to determine whether you need to upgrade your client PC’s and/or server’s hardware or operating system.

To support new features introduced with ChemStore C/S B.03.03 and higher, the database schema for B.04.0x is different than the schema for rev. B.03.02 or earlier. Once a database has been migrated to the new schema it cannot be used with the previous version of ChemStore software. New and enhanced features in ChemStore revision B.04.0x include:

- Support for Oracle 10g
- Support for Windows Vista
- Support of Microsoft Access Runtime 2007
- Enhanced zooming and display of chromatograms

Please refer to the readme file and software status bulletin (SSB) which are found on the software CD-ROM for changes and a detailed list of defect fixes.
Upgrading Revision B.01.0x, B.02.0x or B.03.0x Server

The upgrade to rev. B.04.02 server starting from a rev. B.01.0x or B.02.0x server typically includes upgrade of the server hardware, the operating system, the Oracle installation and the ChemStore database schema. The upgrade starting from a rev. B.03.0x server typically includes upgrade of the Oracle installation and the ChemStore database schema.

Agilent recommends performing this migration task by using the Oracle database export and import functionality. It allows a direct upgrade from Oracle 7, 8i, or 9i to 10g, the database gets defragmented and the destination database gets created with initial parameters optimized for usage with Oracle 10g.

The following briefly describes the major steps that are required when upgrading the ChemStore server to revision B.04.02 and keeping the server hardware platform. If the server hardware is planned to be updated, the new production server can replace the development server and parts of the following completion steps can be skipped. The details of the server migration project should be discussed and planned with the help of an Agilent consultant.

NOTE

There are other alternatives, such as performing the upgrade and migration on the existing server. However, a single-server upgrade will not allow for a quick roll-back in the event that the upgrade fails, leaving your laboratory with extended down time. Also, Oracle 9i server cannot be cleanly un-installed, so this approach is not recommended. Your Agilent consultant can present you with the various options before the upgrade is performed.
Set-up of development server or new production server

- Configure the new server with the same host name and IP address as your old server.
- Perform a complete backup of the new server in this “pre-Oracle” state.
- Install Oracle 10.2.0.4.0 Server, ChemStore Server software version B.04.02 and a new ChemStore database on your new system. The dimension of the new database should be based on the size of the current production database. It should be increased if the number of ‘active’ runs in database was insufficient or a further expansion of the client/server system is planned.
- Start SQL Plus and log on as user **system** and drop the user **csinternal**. All ChemStore specific tables are stored under this user. The server is now ready to import the database export generated in the next step.

Database export on production server

- Log on to the ChemStore database and verify the presence of an administrative user account with sufficient privileges for migrating the database. This user should have a password assigned.
- Shut down all clients and inspect the spooler folder for pending spool jobs.
- Once all jobs are spooled: Stop the ChemStore Archive Server service and shut down the database instance.
- Perform a complete Oracle export of the database.
- Turn off the production server.

Database import on development server or new production server

- Import the database dump file.
- Verify that the import worked as expected, by checking the table contents with the ChemStore Admin Tool.
- While importing and migrating the database, upgrade and validate the client systems. This could simply be done by replacing the PC hardware.
Database Schema Migration Steps

- Install and configure at least one ChemStore C/S B.04.02 client on a new client system.
- Perform the database schema migration from the client using the AgtDbCF.exe utility provided with the B.04.02 Data Management Module software.

Completion Steps

1. Perform a full system backup as well as a cold backup of the migrated database.

If you intend to continue using the old production server’s hardware continue with step 2 - 6. If the database import server should be the new production server continue with step 7.

2. Restore or configure the production server to a pre-Oracle state. This can be done by either installing a fresh operating system, restoring a tape of a pre-Oracle configuration, or by attempting to uninstall the Oracle 9i Server software and ChemStore C/S software manually.

3. Install Oracle 10g Server software on the production server, following the instructions in Chapter 3, “Client/Server Installation,” starting on page 31. Use the default Oracle home and installation directory that you used before.

4. Install ChemStore C/S Server software version B.04.02 and configure a small database using the same database name as before.

5. Change the user csinternal's password to the production database’s password using the ChemStore C/S Admin Client

6. Stop the database instance and services for the empty small database and delete the database files.

7. Restore the migrated database from your development server backup, as well as the control files, initialization file, password file and global configuration file.

8. Validate the server and database installation, as well as the B.04.02 client.

9. Reconnect the clients and put the system into production
7

Troubleshooting Tips

Troubleshooting Network Connections  114
Resolving Name Resolution Problems  115
Troubleshooting Net Connectivity  117
Repeat the TNSPing test to verify that this corrective action solves the
connectivity problem.  119
Troubleshooting Access Security Problems  120
Troubleshooting Installation Problems  122

The following troubleshooting tips are provided to assist you in resolving
potential difficulties that may occur during installations.
Troubleshooting Network Connections

The ChemStore Server installation program installs several operating system services which are critical to the operation of the server. These services are described in this section.

1. Open a Command Prompt window on your client system (Start > Search > CMD).

2. Type Ping <hostname> where <hostname> is the host name of the server.

3. You should see a response showing four ping attempts and four successful responses as shown in the following figure.

4. The following problems can be determined using the Ping utility:
   - Name Resolution problems.
     These will typically respond with “Bad address” or “Unknown Host” messages. In the event of a name resolution problem, refer to “Resolving Name Resolution Problems” on page 115.
   - Connectivity or address problems
     These will typically respond with “Request timed out” messages. In the event of a connectivity or address problem, attempt to ping another system within your subnet to isolate the cause of the problem. If you are unsuccessful with this, contact your IT support group to assist you.
Resolving Name Resolution Problems

In order for the client systems to access the database server, they will need to resolve the server’s host name to its IP address. This function is typically performed by the DNS name server on a network.

In the event that a DNS server is not available or there is a problem with name resolution, you will find that attempts to ping the server by its name result in errors, while pinging the server’s IP address works.

In this case, the best workaround is to place an entry in the HOSTS file on your client to map the server’s IP address to its host name.

1. On the client: Go to Start > All Programs> Accessories > Notepad, right-click the Notepad icon and select Run as administrator
2. Confirm the User Account control message
3. Choose File > Open, change the file type from .txt to All files (*.*) and locate the file HOSTS in the \Windows\system32\drivers\etc subdirectory.
4. Enter an address mapping entry in this file as shown in the following figure.

![Figure 60 Editing Windows Hosts File](image-url)
7 Troubleshooting Tips
Resolving Name Resolution Problems

5 Test the mapping using the ping command from a command prompt window as shown in the section “Troubleshooting Network Connections” on page 114. You should see a response showing four ping attempts and four successful responses.
Troubleshooting Net Connectivity

Net connectivity is established using the Net Service name established locally on either clients or the server. This Net Service name maps to the TNSListener service on the server and redirects network access requests to the Oracle database. The primary troubleshooting tool for Net connectivity is the TNSPing command-line utility supplied with the Oracle software.

1. Open a Command Prompt window on the system you wish to test.
2. Type **TNSPing** and the **Net Service name** you are testing followed by **Enter**; for example:

   TNSPing dbserver_hpcs

   ![Figure 61 Testing NetService Name resolution with TNSPing command](image)

The above example represents a successful test of the Net connectivity. This indicates that the Net Service name was properly mapped to the server, and that the server has a valid TNSListener service running and has responded on the correct port number.

**TNS Listener problems**

If the Oracle Server was not installed or configured correctly, you will see an error “no listener” when attempting to use TNSPing. This is most often associated with either the TNS Listener service not being started or
configuration errors in the Listener. Contact your Agilent Support representative to assist you in troubleshooting TNS Listener communications errors.

**Net Service Name problems**

If the Net Service name was not correctly established, you will see an error “Cannot resolve name” when attempting to use TNSPing. This is most often associated with an automated-append feature of the Net Configuration Assistant; which will add the fully-qualified domain name to any service name created if the computer participates in a TCP/IP domain.

Generally, having the fully qualified domain name in the net service name will not be problematic, however, if the server is located in a different TCP/IP domain than the clients then the domain information will be incorrect and the connection will fail.

Follow these steps to identify and correct problems with the Net Service name:

1. Open a **Command Prompt** window on the system you wish to test.
2. Type **TNSPing** and the **Net Service name** you are testing followed by **Enter**; for example:
   
   ```
   TNSPing dbserver_hpcs
   ```

3. If the TNS Ping returns a Failed to resolve name error, proceed with the corrective actions.

4. To verify that the problem is related to the fully-qualified name feature, open the Windows **Notepad** program as administrator (right mouse click, run as administrator) and open the file **Tnsnames.ora** which is located in the \oraclе\product\10.2.0\client_1\NETWORK\ADMIN subdirectory.
5 Make sure that the name section established for the ChemStore C/S database connection is similar to the following figure. If not, correct it in Notepad and save the file.

![Editing the Tnsnames.ora file](image)

**Figure 62** Editing the Tnsnames.ora file

6 Repeat the **TNSPing** test to verify that this corrective action solves the connectivity problem.
The installation of the ChemStore C/S Server creates a share named Config which contains a file called the global configuration file. Each ChemStore C/S client must be authenticated to access this configuration file from the share on the server.

To determine whether the client computer has access to the config share, perform the following test:

1. Open the Windows explorer
2. Enter `\hostname\config` in the address bar, where hostname is the name of your server (e.g. `\csserver\config`)
3. Click on Refresh

If you have the required access to the config file, the Windows explorer displays a folder which should contain the `hpdbglob.cfg` file.

If you do not have the required access to the config file, Windows will prompt you for a password. This demonstrates an authentication problem with your server. Do not enter a different user name and password to connect to this share, as this will only be a temporary solution and your connection will again fail when your client has been restarted.
If you are prompted for a password, ask your Server administrator to resolve the authentication problem between the client and server. Agilent recommends that the clients and server participate in a Windows domain, and that all domain users be granted read-access to the config share on the database server.
Troubleshooting Installation Problems

Installation problems may occur on either the server or client systems. Log files are generated to help troubleshoot the cause of any installation problems. These should be checked and will be needed by any Technical Support personnel you may contact for assistance.

Checking the Server Log Files

If any of the services that the installation program creates are missing or not started after installation (except the ChemStore C/S archive server, which you must start), some of them might have not installed successfully.

✔ On the Server system, check the installation log, *csServer.log*. Look for messages that indicate a failure to start a service. Look for the following line, toward the end of the file.

*Finished creating Oracle stored procedures*

✔ If error messages during server installation indicate an Oracle database was not successfully created, check the *csDbmk.log* file. If the database was created successfully, the following line would appear at the bottom of the file:

*ChemStore CS database has been successfully created!*
Checking the Client Installation Log File

Check `chem32\ChemStor\install\csClient.log`.

✔ If you installed the Stand-alone version, look for the following line, toward the end of the file.

   Files registered successfully

✔ If you installed the Client/Server version, look for the following line, toward the end of the file.

   ODBC files installed successfully
7 Troubleshooting Tips
Troubleshooting Installation Problems
This chapter describes the correct procedure for removing the various parts of the ChemStore C/S software from your systems. The un-installation tasks are not difficult to perform; however these steps must be followed correctly so that the software can be cleanly removed in preparation for either new revisions of software or for redeployment of your client PC hardware.

Use the instructions in this section to correctly remove ChemStore and Oracle client software from your client and standalone systems.
De-installing the ChemStore Client Software

The ChemStore Data Management Module software is de-installed using the **Programs and Features** utility which is accessed from the **Control Panel** in Windows Vista. The automated software removal will correctly remove the Data Management Module software and related components.

The procedure will ensure a complete removal of all program files and registry entries that were made during installation. However, files that were changed after the installation will not be removed. Typically these are the databases, snapshot database, system database, and log files. Those files are stored in work directories under `\\chem32\chemstor` and the hidden folder `Users\<current user>\AppData\Roaming\ChemStore`.

1. Restart your computer and log-on to Windows as a user with administrative capabilities.

2. If you have Agilent Technologies DB Size Security Service installed, remove the DB Size Security Service software before uninstalling the ChemStore C/S Data Management Module.

3. If you have ChemStore Service Releases installed, remove the Service Release in the **Programs and Features** utility.

4. If you have ChemStation Plus Security Pack installed a special file permission on file `\\chem32\chemstor\spool\readme.txt` protects the spool folder from deletion during the de-installation process. Before proceeding verify the absence of any pending spool job and grant yourself ‘full control’ permissions on the mentioned readme.txt file.
5 Select **Start > Control Panel > Programs and Features** to open the following dialog box.

![Add/Remove Programs](image)

**Figure 64** Add/Remove Programs

6 Select the client software, such as **ChemStore C/S - Client B.04.02** and click on **Uninstall/Change** to start the de-installation.

7 Read the warning and select **Yes** to start removing the program files from your computer.

8 During the file removal process you will be asked whether to remove shared files. Agilent suggest that you remove all shared files of ChemStore C/S, as the appropriate revision of these files will be re-installed with the ChemStore C/S B.04.02 or higher Data Management Module, and thus compatibility is ensured. Select **Yes To All** to remove all shared files, read the warning and click **Yes** to continue.

9 If you are confident in your database backups, you may then delete the directory `chem32\chemstor` to remove all these temporary and left over files. There may be a warning that this action could impact registered programs;
8 Removing Client Software
De-installing the ChemStore Client Software

however if you have not installed any other programs in this directory, it is safe to ignore the warning.

10 Restart your system after uninstalling the Data Management Module and ensure that the ChemStation instrument sessions (if present) can be started without error.
Uninstalling Oracle 10g Client Software

The Oracle 10g client software are de-installed using the Oracle Universal Installer located under All Programs > Oracle-OraClient10g_home1 > Oracle Installation Products.

Follow these steps to remove the Oracle 10g client software.

1. Log-on to Windows as a user with administrative capabilities.
2. Start Oracle Universal installer from All Programs > Oracle-OraClient10g_home1 > Oracle Installation Products.
3. Click the De-install Products button in the installer welcome screen.
4. Expand and then select the check boxes for the OraClient10g_home1 in the inventory window. Then click on Remove button.

![Figure 65 Oracle Inventory summary](image-url)
8 Removing Client Software
Uninstalling Oracle 10g Client Software

5 A confirmation window will be displayed showing the products to be uninstalled. Click Yes to confirm removal of the Oracle 10g client software.

![Confirmation dialog for delete operation](image)

**Figure 66** Confirmation dialog for delete operation

6 Once the software has been removed, the inventory window will be displayed. This window should show that no products are installed.

7 Click on Close button to close the inventory window and then click Cancel to close the Oracle Universal Installer.

8 Restart your system after uninstalling the Oracle 10g client software to remove any remaining configuration parameters.

9 Use Windows explorer to delete remaining Oracle installation directories.
This chapter describes the correct procedure for removing the various parts of the ChemStore server software from your systems.

Due to the critical nature of a server in a client/server environment, these tasks are not recommended unless you are a trained Oracle server administrator. Agilent recommend that you consult a trained engineer or consultant before attempting these tasks; Otherwise you may inadvertently cause data loss or excessive laboratory downtime.

Use the instructions in this section to remove the ChemStore and Oracle Server software to prepare for an upgrade or redeployment.
Uninstalling ChemStore Server Software

Use this procedure to uninstall the ChemStore Server software from your database server. This procedure can also be used for previous revisions of ChemStore Server software.

NOTE

The uninstallation of ChemStore server software does not remove the ChemStore database. ChemStore server software can be re-installed without removing and recreating the Oracle database.

1 Log-on to your server as a user with administrative capabilities.
2 Before removing the ChemStore Server software, it will be necessary to stop the ChemStore C/S Archive Server service.
3 From the Control Panel > Administrative Tools, select Services and locate the ChemStore C/S Archive Server service. Select this service and stop it.
4 Select Start > Settings > Control Panel > Add/Remove Programs to open the Add/Remove Programs Properties dialog box.

Figure 67 Add/Remove Programs
5 Select **ChemStore C/S - Server B.04.02** in the **Add/Remove Programs** Properties panel to remove the ChemStore C/S server software.

The procedure above will ensure a complete removal of all program files and registry entries that were made during installation. This does not remove the database or files that were changed after the installation. Typically these are the log files created during operation of the server and the global configuration file.

6 Restart your server before attempting to re-install the ChemStore C/S software. This step is crucial for a complete removal of the ChemStore CS Archive Server service.
Removing a ChemStore Server Database

The ChemStore Server database can be removed with the help of the Oracle 10g Database Configuration Assistant. This tool removes all database files and instance related services created by the ChemStore installation program. The utility is intended for use by Oracle DBAs or Agilent engineers to remove the ChemStore server database for service reasons such as re-installing the software or removing a temporary database in preparation for a database restore.

CAUTION

This utility removes all ChemStore server database files from your server. It requires no password and can be used by anyone accessing the server. The database files and all the data will be completely erased. This utility should be used with extreme caution and the server needs to be protected accordingly.

1. Back-up your Oracle database to a different directory than the one you are using for ChemStore C/S.
2. Start Programs \ Oracle - OraDB10g_home1 \ Configuration and Migration Tools \ Database Configuration Assistant
3. At the Welcome screen press Next
4 The following screen offers the option to delete a database. Select this option and press **Next**

![Database Configuration Assistant, Step 1 of 2: Operations]

**Figure 68** Oracle Database Configuration Assistant, database deletion

5 The following screen shows a list of all available databases. Select the database you intend to delete and press **Finish**

6 In the summary screen confirm the database deletion by pressing **Yes** and the deletion process gets started.
De-installing Oracle 10g Server Software

The Oracle 10g server software is installed using the Oracle Universal Installer which was installed with the Oracle server software. The Oracle Universal Installer can also be run from the original Oracle DVD.

Follow these steps to remove the Oracle 10g server software.

1. Log-on to the server as a user with administrative capabilities.
2. Select Programs > Oracle - OraDB10g_home1 > Oracle Installation Products > Universal Installer from the Windows Start menu.
3. Click the De-install Products button from the Oracle Universal Installer welcome screen.
4. Expand the sections and check the selection boxes for the products under Oracle Homes and click Remove.
5 Review the confirmation window and click **Yes** to remove the Oracle Server software from your system.

![Confirmation dialog for delete operation](image)

**Figure 70** Confirmation dialog for delete operation

6 Once the software has been removed, the inventory window will be displayed. This window should show that no products are installed.

![Oracle Inventory summary after complete de-installation](image)

**Figure 71** Oracle Inventory summary after complete de-installation
9 Removing Server Software
De-installing Oracle 10g Server Software

7 Click on the Close button to close the inventory window and then click to close the Oracle Universal Installer.

8 Restart your system after de-installing the Oracle 10g Server software to remove any remaining configuration parameters.
Some of the server administrative tasks are performed using the ChemStore C/S Admin Client, which is accessed from the Agilent ChemStation program group. Refer to the ChemStore C/S Admin Client online help for more information on performing these server administrative tasks.
The ChemStore C/S Server installation program installs several operating system services which are critical to the operation of the server. These services are described in this section.

1. From the Windows **Start** menu, choose **Settings > Control Panel > Administrative Tools > Services.**

2. Check the status and startup mode of each of the following services. They should be in the **Started** status and be set for **Automatic** startup:
   - Oracle TNS Listener Service (OracleOraDB10g_home1TNSListener)
   - Agilent ChemStore C/S Archive Server. The installation program sets this service to Automatic startup, but does not automatically start it. The first time you use the product after you install (and only the first time), you must start it. Click **Start** in the **Services** dialog box.
   - OracleService\database\name (e.g. OracleServicehpcs). The installation program sets this service to Automatic startup, but does not automatically start it until you restart your server after creating database
If any of these services are missing or not started after installation (except the ChemStore C/S Archive Server, which you must start), you will need to call an Agilent support representative to assist you in troubleshooting the installation.

3 Check that the service **Distributed Transaction Coordinator service** is not set to start up. Identify this service and make sure that it’s set for startup mode **Manual** or **Disabled** as shown in the figure on page 140.
Installing the ChemStore C/S Admin Client Utility

The ChemStore C/S Admin Client utility is used to administer the ChemStore C/S server, and can be run from the server or any networked client from the Internet Explorer web browser.

By default, the ChemStore C/S Data Management Module and ChemStore C/S server installations will place an internet shortcut in the ChemStore CS programs folder to access the Admin Client web application.

Follow these instructions to successfully load the ChemStore C/S Admin Client.

1. Make sure you have started the ChemStore C/S Archive Server service on the ChemStore server.
2. Right-click on the Internet Explorer icon in the Windows start menu and choose Internet Properties.
4. Set the security level to Low for the Local Intranet group.
5. Click Apply.
6. Choose All Programs > Agilent ChemStation > ChemStore Admin Client from the Windows Start menu.
7. The Java runtime environment 6.0 installer will start and will install the software and plug-in on your system.
8. Set back the security level to Medium for the Local Intranet group. If security level High is required, add the Admin Client to the list of trusted sites.

**NOTE**

In order to successfully download the Java runtime software, you need to change the security setting in Internet Explorer to avoid getting a security alert. The Admin Client requires the Java runtime plug-in to be installed onto your local machine. ChemStore C/S automatically attempts to install the software the first time you run Admin Client, if it has not already been installed on your local machine.
9 After the installation of the Java runtime plug-in, the Admin Client page will refresh and should load correctly. The following figure illustrates how the Admin Client web application should appear.

Figure 73  ChemStore C/S Admin Client - Microsoft Internet Explorer
10 Check the **ChemStore Alias** field. Your database name (e.g. *atcs*) should be displayed in the header information of the admin client. You do not have to log-on to the database to see this information.

11 Click on the **Login** button and enter the default administrator account information (user *admin* with password *admin*).

![ChemStore Admin Client User Login](image)

*Figure 74* ChemStore Admin Client User Login
Changing the Database Description

During installation the server database is created with a default description that may or may not be meaningful to you. Since this description appears when the clients connect to the database, you should change it to something meaningful. This is especially important when clients might connect to multiple ChemStore C/S databases.

The database description is stored in the global configuration file. It is changed from the ChemStore Admin Client utility.

To change the description of the database, follow these steps:

1. Start the ChemStore Admin Client in your web browser.
2. Log-on to the Admin Client as the user admin.
   The default password is admin.
3. Select Change global config information from the Global Config selection list.

   Figure 75  Change global config information
4. Select the **Description** radio button.

5. Enter the new description in the proper field. It is best to leave the creation date/time stamp intact in the description; however the rest of the description can be changed.

6. Click **OK** to accept the changes.

For more information on the ChemStore Admin Client refer to the online help.
Changing the Default Passwords

Several passwords and users are required for successful operation of the ChemStore C/S system. We strongly recommend that all default passwords be changed after installation to prevent unauthorized access to the ChemStore C/S data. This is very important for laboratories operating under regulatory requirements, as the application can not audit changes to the database which are done outside the ChemStore C/S application environment.

ChemStore C/S internal user

During installation of the ChemStore C/S Server software, the installation process creates the Oracle user *csinternal* with a password of *csinitorapswd*. This user is used by all ChemStore C/S components to access the Oracle database.

The correct setting of the user *csinternal* and its password is essential for the correct operation of a ChemStore C/S System. You should not change the password of the user *csinternal* using Oracle tools, always use the ChemStore C/S Admin Client to change the password.

To change the password for the *csinternal* user, follow these steps:

1. Start the ChemStore Admin Client in your web browser.
2. Log-on to the Admin Client as the user *admin*.
   - The default password is *admin*.
3. Select **Change global config information** from the **Global Config** selection list.

   ![Change global config information](Image)

   **Figure 77** Change global config information
Select the **Password** radio button. Enter the new password for your ChemStore C/S internal user account; then enter it again when prompted.

![Change password in global configuration file and database](image)

**Figure 78** Change password in global configuration file and database

**CAUTION** It is very important that you **do not** change the password for the *csinternal* account using standard Oracle tools as this inhibits the correct operation of your ChemStore C/S System.

For more information on the ChemStore Admin Client refer to the online help.
Oracle Default Users

Whenever you create a new Oracle 10g database, there are three default users created by Oracle. For security reasons Agilent recommend to change the passwords for these users after installation.

<table>
<thead>
<tr>
<th>User Name</th>
<th>Password</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>system</td>
<td>manager</td>
<td>Used for administrative tasks of the database</td>
</tr>
<tr>
<td>sys</td>
<td>change_on_install</td>
<td>Used for maintenance tasks</td>
</tr>
<tr>
<td>outln</td>
<td>outln</td>
<td>Required for Optimizer plan stability feature</td>
</tr>
</tbody>
</table>

Oracle Users sys, system, and outln

Perform the following steps to change the password of the users sys, system, and outln that are used to maintain the Oracle database. Do not use this procedure for user csinternal (see page 147).

1. Open the Oracle Enterprise Manager Console and logon as user csinternal with SYSDBA privileges and the password set in previous section.
2. Navigate the Network tree view down to databases\CSSERVER_HPCS-CSINTERNAL\Security\Users.
3. Enter and confirm new passwords for the users sys, system, and outln.
4. Press the Apply button after changing each password.
5. Select File > exit; to exit the Oracle Enterprise Manager Console.

Further on, Oracle recommends locking the outln account and only unlock it in case a DBA needs access to it for maintenance operations.

Oracle User internal

This account is used by the operating system services to start-up and shut down the database. On Windows operating systems the access to the internal account is controlled by the Windows authentication, whereas UNIX based
operating systems make use of a password file stored on the database server. All users who are authenticated as a member of the ORA_DBA group on the database server will be granted access to the Oracle *internal* user account.

On UNIX systems follow these steps to change the password for the *internal* account.

1. Log-on to the server as a member of the ORA_DBA group
2. Open a **Command Prompt** window on your server.
3. Start SQLPLUS with the following command:
   ```sql
   sqlplus /*as sysdba"
   ```
4. Shutdown the database: SQL> shutdown immediate
5. Locate the password file for the internal account.
   This file will typically be located in the `Oracle\product\10.2.0\db_1\database` directory and will be called `pwdhpcs.ora` (or `pwdxxxx.ora` where `xxxx` is the four character database name).

   **NOTE**
   The internal password file is a hidden file, so you will need to enable viewing hidden files in the Windows Explorer.

6. Delete the internal password file.
7. A new password file can be created using the **Orapwd** utility using the following steps.
8. Open a second **Command Prompt** window on your server.
9. Change to the directory `Oracle\product\10.2.0\db_1\database`
10. Type the following command:
    ```bash
    Orapwd file=pwdhpcs.ora password=<newpassword>
    ```
    **NOTE**
    If your database name is not hpcs, change the name of the password file in this command accordingly.

11. At the SQL prompt startup the database again: SQL> startup
Shutting Down the Database Instance

In order to perform maintenance activities on the server, it may be necessary to shut down the database instance to remove user connections and release the file locks that Oracle maintains on the database files.

Perform these steps to shut down the database on any client or the server.

1. Log-on to the operating system as a member of the ORA_DBA group.
2. Stop the ChemStore C/S Archive Server service. This will ensure that on-going archive/de-archive/delete operations are finished. If the Archive Server Service cannot be stopped it is very likely caused by an on-going archiving/de-archiving/deletion process. Use the ChemStore Admin Tools to monitor the current activity of the Archive Server Service. Shutting down the database without stopping the service does not damage the records as long as the shutdown is not a "forced" one.
3. Open a Command Prompt window.
4. Start SQLPlus with the following command:
   
   sqlplus /nolog

5. Connect to the database as a user with SYSDBA privileges:

   connect csinternal@csserver_hpcs as sysdba

6. Enter the password

7. Shutdown the database: SQL> shutdown immediate

8. All users will be disconnected from the database immediately and all transactions in progress will be rolled back to their pre-transaction state.

9. Once the database has been shut down, SQLPlus should report "Oracle instance shut down".

10. Select SQL > exit; to exit SQLPlus.

Consult your Oracle documentation for more information on administering your Oracle database.
Restarting the Database Instance

In order to perform maintenance activities on the server, it may be necessary to shut down the database instance to remove user connections and release the file locks that Oracle maintains on the database files.

After performing these activities, you may wish to restart the database instance without restarting your server. Perform the following steps to restart your database on the server.

If you had previously also shut down the database instance service from the Control Panel, you will need to restart the instance service. Restarting the instance service will automatically restart the database instance.

1. Log-on to the operating system as a member of the ORA_DBA group.
2. Open a Command Prompt window.
3. Start SQLPlus with the following command:
   
   `sqlplus /nolog`

4. Connect to the database as a user with SYSDBA privileges:
   
   `connect csinternal@csserver_hpcs as sysdba`

5. Enter the password
6. Startup the database using the command:
   
   `SQL> startup`

7. The startup activities will be reported as they are performed. You will see the database instance as it is first mounted and then opened.

8. Once the database instance has been restarted, SQLPlus should report “Database Opened”.

9. Select `SQL > exit;` to exit the SQL Plus Worksheet application.
10. Consult your Oracle documentation for more information on administering your Oracle database.
Back up the Database Files

The following instructions describe how to perform a cold backup of a default ChemStore C/S database which has been named hpcs. For customized installations, you should contact your Agilent support representative to assist you in creating an appropriate backup routine.

More information on backup and archiving concepts can be found in the ChemStore C/S Concepts Guide.

1 Shut down the Database Instance using the Oracle Server Manager. See “Shutting Down the Database Instance” on page 151.

2 Stop the Oracle Instance Services from the Control Panel.
   a Choose Settings > Control Panel > Administrative Tools and start the Services application.
   b Locate the service named OracleServicehpcs. Select this service and click on Stop to stop the service.

3 Start the back-up program, which may be either Windows 2003 Backup or a third-party backup program of your choice.
   - On Windows 2003 systems, Backup is located in the Programs > Accessories > System Tools folder under the Start menu.

4 Back-up the \dbs\hpcs directory on each of your ChemStore C/S server drives.

The files in these directories are listed in Table 9, that also describes the content of each of these files as well as their default sizes:
10 Administration and Reference Information
Backing Up the Database Files

Table 9 Database File Description and Size

<table>
<thead>
<tr>
<th>File name</th>
<th>Description</th>
<th>Small Database</th>
<th>Medium Database</th>
<th>Large Database</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data1_1</td>
<td>archive information, methods, spectra</td>
<td>100 MB</td>
<td>200 MB</td>
<td>1000 MB</td>
</tr>
<tr>
<td>Data2_1 +x</td>
<td>binary large objects (BLOBS), raw data</td>
<td>1000 MB</td>
<td>7000 MB in 4 files</td>
<td>30,000 MB in 15 files</td>
</tr>
<tr>
<td>Data3_1</td>
<td>user information</td>
<td>100 MB</td>
<td>200 MB</td>
<td>1000 MB</td>
</tr>
<tr>
<td>undotbs01.dbf</td>
<td>undo files used for rollback</td>
<td>100 MB</td>
<td>500 MB</td>
<td>1000 MB</td>
</tr>
<tr>
<td>temp01.dbf</td>
<td>temporary information</td>
<td>100 MB</td>
<td>100 MB</td>
<td>100 MB</td>
</tr>
<tr>
<td>INDX_1</td>
<td>data retrieval index files</td>
<td>500 MB</td>
<td>800 MB</td>
<td>1000 MB</td>
</tr>
<tr>
<td>SYSTEM01.dbf</td>
<td>system table definitions</td>
<td>250 MB</td>
<td>250 MB</td>
<td>250 MB</td>
</tr>
<tr>
<td>SYSAUX.DBF</td>
<td>Oracle 10g syssaux</td>
<td>up to 2000 MB</td>
<td>up to 2000 MB</td>
<td>up to 2000 MB</td>
</tr>
<tr>
<td>Redo0X.log (x=1,2,3,4)</td>
<td>log table</td>
<td>10 MB</td>
<td>20 MB</td>
<td>50 MB</td>
</tr>
</tbody>
</table>

5 Back-up the ChemStore control files Control01.ctl and Control02.ctl.

The system stores two copies of this file for data integrity; back-up both copies. For a default installation, Control01.ctl will be in the \oracle\product\10.2.0\db_1\dbs\hpcs directory and Control02.ctl will be located in one of your \dbs\hpcs directories.

6 Back-up the database initialization file \oracle\product\10.2.0\db_1\database\inithpcs._ora.

7 Back-up the internal password file \oracle\product\10.2.0\db_1\database\Pwdhpcs.ora.

8 Back-up the ChemStore C/S global configuration file \hpchem\chemstor\config\hpdbglob.cfg.

9 Optional: back-up the Oracle Listener and TNS names files listener.ora, sqlnet.ora and tnsnames.ora located under \oracle\product\10.2.0\db_1\network\admin.

10 Restart the database instance service.
Restoring the Database Files

In case of a data loss or database corruption on your database server you can restore the database to the status at the last full backup.

Before you start the recovery procedure, you must shut down the database instance and service. You will also delete the existing database files before restoring the files from the backup set to ensure that the database is consistent after recovery.

1  Shut down the Database Instance using SQLPlus. See “Shutting Down the Database Instance” on page 151.

2  Stop the Oracle Instance Services from the Control Panel.
   a  Choose Settings > Control Panel > Administrative Tools and start the Services application.
   b  Locate the service named OracleServicehpcs. Select this service and click on Stop to stop the service.

3  Delete the \dbs\hpcs directories from each of the drives on your system.

4  Restore all the database files from the backup into their initial locations on the drives of the server.

5  Restore the control files, initialization parameter file, internal password file and global configuration file; overwriting any files that may already be present.

6  Restart the server. The database instance should start automatically and should contain all the data as of the backup set you restored.
Restoring the Database to a Different Server

In event that you need to restore your database on a different server, such as after a server crash or during a system upgrade, you can follow these steps to restore your database from the last full backup.

1. Install and configure the ChemStore C/S server as described in Chapter 3, “Client/Server Installation,” starting on page 31.

2. Configure and build a small ChemStore database using the same host name and database name as your backed up database.

3. Change the ‘csinternal’ user’s password to match the password of the production system (in case you don’t have a valid copy of the global configuration file). See “ChemStore C/S internal user” on page 147


5. Stop the Oracle Instance Services from the Control Panel.
   a. Choose Settings > Control Panel > Administrative Tools and start the Services application.
   a. Locate the service named OracleServicehpcs. Select this service and click on Stop to stop the service.

6. Delete the dbs\hpcs directories from each of the drives on your system.

7. Restore all the database files from the back-up into their initial locations on the drives of the server.

8. Restore the control files, initialization parameter file, internal password file and global configuration file; overwriting any files that may already be present.

9. Restart the server. The database instance should start automatically and should contain all the data as of the back-up set you restored.
Defragmenting disks and databases

During routine operation of any modern computer system, the file system will become fragmented over time. This fragmentation results in performance loss and may contribute to excessive wear on the disk drives.

A defragmenting tool should be used to reduce or eliminate fragmentation of the system and applications drives on the server, as well as for defragmentation of the drives on client systems.

Defragmenting the Server Disks

**CAUTION**

DO NOT run a defragmentation tool on the Oracle database server while the database is in operation. Always shut down the Oracle database instances before running any defragmenting tools.

Due to the dynamic nature of the Oracle database environment and the extremely large files involved, it is not recommended to defragment the database data files using any disk defragmenter tool. The best approach is to move the files to another disk or to a backup tape first; then defragment the drive and restore the data files to their original locations.

Fragmentation within Oracle also occurs within the tablespaces. This type of fragmentation should be addressed by a trained Oracle Database Administrator or Oracle consultant.
Defragmenting the Client Systems

Defragmenting should be performed as part of a maintenance routine that also includes backing up and virus protection. Client systems should be defragmented on a routine basis to improve system performance.

Compared to the FAT file system, fragmentation of files on an NTFS volume is greatly reduced. By design, fragmentation only occurs on an NTFS volume if a file increases in size after it is on the drive. This means that backing up a volume to tape and restoring it from tape will result in an unfragmented volume. Windows Vista includes a utility for this task.

CAUTION

DO NOT run a defragmentation tool while the clients are acquiring data. Defragmenting requires large amounts of system resources which could cause the data acquisition to be interrupted; potentially causing data loss.

Defragmenting server databases

The following is an extract from the article "Algorithms and Methods for Oracle Defragmentation", by Mike Hordila, Oracle Internals, Vol.4, March 2003

It is well known that I/O is the single most important component of database response time. The slowest component in Oracle enterprise installations is normally the network. The next slowest is at server level, the I/O (input/output) subsystem that is reading and writing to disk. For most installations that do not have an important network component, and especially for large locally run batches, the I/O subsystem becomes the bottleneck. That is why optimizing this component will improve the entire system’s performance.

In databases, fragmentation is a normal occurrence. Fragmentation is scattered free space, associated with scattered pieces of storage space, at block level, extent level, segment level, tablespace level, and memory level. There is no way to avoid it as long as you add, update, or delete records.

There are a few ways to deal with this, of which reorganizing objects is traditionally the most used. The speed of the reorganization can be critical, because access to some database objects may be restricted during the process.
Oracle allocates a fixed amount of contiguous space, called an extent, to hold table and index data at the time an object is created. The size of the allocated space is specified at the time of creation. If no size is specified, a default value (usually 10 KB) is used. If the object fills the initial extent space, another extent is allocated. However, this next extent may not be physically adjacent to the initial extent. Over time, an object might consist of many extents spread throughout the physical disk. In addition, after an extent is allocated, it is not de-allocated until the object is dropped or truncated.

Tablespace fragmentation is characterized by unequally sized pieces of used and free space, left by de-allocated extents when database objects are dropped, or by creating new extents of different sizes in the same tablespace. This causes inefficient use of available database space and limits the growth potential, but has no effect on overall database performance.

In contrast, table and index fragmentation, row chaining, and data dispersion and skewing can cause significant database performance degradation.

The five major criteria for deciding on table reorgs include:

- High numbers of extents (acceptable: <1024 extents for very large objects; look out for extents per object >50)
- High percentages of chained rows (acceptable: <3 percent; look out for percentages >0.1 percent); analyze the tables first
- High percentages of free space inside blocks (look out for FREESPACE/BLOCK > 2*PCTFREE)
- High percentages of free space above high water mark (HWM) (look out for EMPTY BLOCKS ABOVE HWM >50 percent)
- Growth problems - not finding space for the initial/next extent allocation, tablespace running out of space, etc.

The oldest, cheapest, simplest, easiest, and probably the most reliable procedure to defrag a database consists of full schema export, schema drop, and schema import, schema recompile. This technique is suitable for installations with medium-sized databases, lots of free disk space available, and especially with tablespaces organized by schemas.

**ChemStore specific issues**

Naturally, the Agilent ChemStore database is also affected by fragmentation. Especially if the number of extents on table CSINTERNAL.CS_BL is too high. The recommended solution is to export/Drop/import the affected tables.
A good indication on when to start this server maintenance is to execute the following SQL statement on a weekly base:

```
select segment_name, segment_type, extents from dba_segments;
```

If the number of extents is still increasing after a main archive/delete procedure was performed, a defragmentation by export/import should be considered.

The following procedure will create a table with one large extent and the administrator will get a good estimation on how much space is needed to store lab data of a one year period. As a result the table's and tablespace's next-extent size parameter should be adjusted. (One table extent can not use more than one tablespace extent).

When planning the export, the most important question to ask is where to create the dump file and how much space and time it will take. A complete cold backup should be considered before dropping tables (deleting all data).

For the import, it's important to know how much space is needed (tablespace extents) and what import buffer-size parameter should be chosen. (Rows will be imported one by one, but there should be enough buffer size to import the largest row).

---

**CAUTION**

The following procedure should be performed by an Oracle DBA only.

---

### Export/Import Procedure

1. Stop all Oracle clients (all ChemStore review clients & Spoolers)
2. Perform an Oracle cold backup. Restart the server and use it to run this procedure. Stop the “ChemStore C/S Archive Server” service.
3. Start the Windows Command prompt (Start -> Run: CMD)
4. start SQLPlus: `sqlplus /nolog`
5. Connect to your database as user system

```
SQL> connect system@CSserver_hpcs as sysdba
```
6. Enter the password for user ‘system’ when prompted.
7. Calculate the size of table CS_BL to estimate the size of the export file by using the following sql statement:
SQL> select sum(so_sz) from csinternal.cs_so;

8 Check for the largest object stored in the cs_bl table. It gives a reasonable value for the buffer-size parameter used for the data re-import (step 15):

SQL> select max(so_sz) from csinternal.cs_so;

9 If needed, the Oracle Enterprise Manager Console can be used to increase the size of the tablespace extension.

10 Export step: Perform the export, running the EXP command from Windows command prompt window. The command needs to be entered in one single line. Example:

exp system@myserver_hpcs file=c:\myfile.dmp compress=Y
indexes=Y grants=Y tables=CSINTERNAL.CS_BL

The dump file name, drive letter, and alias need to be adjusted to the system specific settings.

11 Enter the password for user ‘system’ when prompted.

12 The export is finished with the message “Export terminated successfully without warnings” appears. In case of any error messages or warnings the procedure should not be continued!

13 (Optional) If the database is in ARCHIVELOG mode, it is recommended to stop that mode before importing a large table later on. (The ARCHIVELOG mode should be restarted after the import process is finished). To execute this step use the following commands in the SQL session:

SQL> connect internal
Password: *******
Connected.
SQL> shutdown immediate
Database closed, Database dismounted, Oracle instance shutdown.
SQL> startup mount
SQL> archive log list
Database log mode: Archive mode
SQL> alter database noarchivelog;
SQL> alter database open;

14 Deletion of the CS_BL table: This is the point of no-return. To undo the whole procedure after the deletion requires a complete rebuild of the database from the back-up. The following commands can be used to delete the CS_BL table:

SQL> drop table csinternal.cs_bl;

15 Import step: The deletion of the CS_BL table created some extra free space on the DATA2 & INDX tablespaces. This space will be used to re-import the table using the 'IMP' command from Windows command prompt. The command needs to be entered in one single line and the dump file name, password, alias name and buffer needs to be adjusted accordingly.

imp system@myserver_hpcs file=c:\myfile.dmp buffer=(refer to step 8) commit=Y full=Y

This step might take several hours (more than time than required to export the tables) and the import is finished when the following message is displayed: “Import terminated successfully without warnings”.

16 Finalizing steps: The next steps are: reviewing next extents parameters, restarting archive log, performing a cold backup and finally informing all users about the finished server maintenance.

17 Open a SQL session and use the following single line command to retrieve the actual size of the first extent and size for the following extents.

SQL> select initial_extent, next_extent from dba_tables where table_name='CS_BL';

18 If needed, the extent sizes for the DATA2 table AND tablespaces should be adjusted using the Storage Manager of the Oracle Enterprise Manager. Depending on the available disc space and a forecast of the future system use, the next extent should be e.g. 50% of initial extent size or a maximum of 1 GB. This should be sufficient for half a year.

19 (Optional) If the system was operating in archivelog mode before, the mode needs to be restarted via a SQLPlus session:

echo%oracle_SID%
SQL> connect internal
The next step is to shutdown the database to prepare another cold backup.

Important: Perform a cold backup according to your standard procedure.

Reboot the server and ensure that all services are running (especially the 'ChemStore C/S Archive Server' service).

Inform all users to resume the spoolers on all clients.

Defragmenting client databases

Defragmenting an MS Access database can be done by the Compact and Repair function of the ChemStore Utility. A backup of the database must be generated before starting the compacting procedure.
Defragmenting disks and databases
All computer systems that participate in a network are vulnerable to attack by computer viruses and other malicious programs.

Agilent strongly recommend that an active anti-virus utility be installed on both the client and server systems to protect against infection. It is important to understand that even this measure does not guarantee that systems will not become infected.

A good anti-virus procedure will include:

- Purchasing and deploying a reputable anti-virus software
- Receiving updated virus signatures from the anti-virus software vendor on a regular basis
- Installing operating system Service Packs and hot fixes as they are issued
- Turning off unused services and ports on both the client and server
- Enabling strong authentication methods and disabling guest access to the server
- Periodically reviewing access logs and system logs for unusual activity
- Subscribing to a news service that reports new virus activity
- Locating your systems behind a secure firewall

No single action can keep your systems safe, but a good operating and administration procedure can fend off most virus attacks.

Concepts guide for further information on the time zone settings and how the recorded times are affected.

For performance reasons it is recommended to exclude the database files from virus scanning. Altered files will anyhow make the database unusable and virus scanning can be manually triggered then.
Power Failure Protection

Due to the dynamic nature of the Oracle database architecture, it is extremely important that the database is shut down correctly and that all transactions are either committed or rolled back in a consistent fashion.

For this reason, an uninterruptable power supply (UPS) is required for all ChemStore C/S server systems. It is important to understand the concepts of power failure protection to properly configure the UPS.

The following points should be considered when configuring the UPS.

• The purpose of the UPS is to properly shut down the database and the server, not to keep it running indefinitely during a power failure.

• Most power failures last less than 10 minutes. If you configure your UPS to shut down the server during this time, you will then need to wait until the server is completely shut down before restarting it.

• You cannot interrupt the shutdown process and attempt to restart your server if power is restored during a shutdown.

• Shutting down a large database can take a long time, in some cases over an hour depending on pending transaction volume. Make sure that your UPS has enough capacity to keep the server running for this length of time.

• Consider unusual circumstances when configuring and sizing the UPS; such as how a shutdown might be affected by a power failure during a database backup.

• Make sure that the configuration is correctly set so that the server is not restarted unless the UPS battery level is sufficient to shut down a second time in the event of a subsequent power failure.

• Periodically measure the time needed for database shutdown and compare it with your UPS runtime capacity. Upgrade your UPS unless you have a significant margin for extended shutdown time.

• Test the UPS shutdown process before placing your database server into production status.
Clearing the Archive Server Log File

The *hparsv.log* file logs archive-related activity on the server, such as archive and de-archive operations. The ChemStore C/S system appends information to this log, so the file can grow to a large size. Periodically copy and rename this file, and then delete the original file. The system creates another one.

The default location of this file is `C:\hpchem\ChemStor\hparsv.log` where `C` is the drive where you installed the ChemStore C/S server.
Optimizing the Server Configuration

It is highly recommended that you use multiple disk arrays for your ChemStore C/S database files. Since the database software performs many simultaneous read and write operations, separating the different types of database files onto separate arrays increases performance measurably. To specify separate locations for these files during the installation, refer to step 3 in the section “Create the Oracle Database” on page 60. Relocation of files in an existing database can only be performed by an Oracle trained database administrator.

See also “Server Performance Considerations” on page 39 for more information on disk array configurations.

Disable Unnecessary Databases

In the event that you installed the sample database called ORCL, you can disable this database to save memory and improve performance. From the Services application, set the OracleServiceORCL service to start-up mode “Disabled”. For details on accessing the services application, see “Checking the Server Services” on page 140.
ChemStore C/S Files

The ChemStore C/S installation program creates configuration files, initialization files, and log files on the ChemStore C/S system as described in the tables below.

Do not alter any of these files; they are listed for your information only.

Table 10  Client Files

<table>
<thead>
<tr>
<th>File name</th>
<th>Description</th>
<th>Default location</th>
</tr>
</thead>
<tbody>
<tr>
<td>csClient.log</td>
<td>Logs client installation information</td>
<td>Chem32\ChemStor\install</td>
</tr>
<tr>
<td>csClList.log</td>
<td>Client file list</td>
<td>Chem32\ChemStor\install</td>
</tr>
<tr>
<td>ChemStoreCS.log</td>
<td>Logs Data Management Module actions</td>
<td>Chem32\ChemStor\work</td>
</tr>
<tr>
<td>hpdblog.txt</td>
<td>Database spooler log file</td>
<td>Chem32\ChemStor\temp</td>
</tr>
</tbody>
</table>

Table 11  Server Files

<table>
<thead>
<tr>
<th>File name</th>
<th>Description</th>
<th>Default location</th>
</tr>
</thead>
<tbody>
<tr>
<td>hpcs.cfg</td>
<td>Specifies tablespace size and location</td>
<td>HPChem\ChemStor\install</td>
</tr>
<tr>
<td>initSml.ora</td>
<td></td>
<td></td>
</tr>
<tr>
<td>initMed.ora</td>
<td></td>
<td></td>
</tr>
<tr>
<td>initLrg.ora</td>
<td></td>
<td></td>
</tr>
<tr>
<td>csSmall.cfg</td>
<td></td>
<td></td>
</tr>
<tr>
<td>csMedium.cfg</td>
<td></td>
<td></td>
</tr>
<tr>
<td>csLarge.cfg</td>
<td></td>
<td></td>
</tr>
<tr>
<td>csSvrList.log</td>
<td>Server file list</td>
<td>HPChem\ChemStor\install</td>
</tr>
<tr>
<td>csServer.log</td>
<td>Logs server installation information</td>
<td>HPChem\ChemStor\install</td>
</tr>
</tbody>
</table>
Table 11  Server Files (continued)

<table>
<thead>
<tr>
<th>File name</th>
<th>Description</th>
<th>Default location</th>
</tr>
</thead>
<tbody>
<tr>
<td>hpdbglob.cfg</td>
<td>ChemStore global configuration file</td>
<td>HPChem\ChemStor\config</td>
</tr>
<tr>
<td>csDbmk.log</td>
<td>Logs database creation information</td>
<td>HPChem\ChemStor\install</td>
</tr>
<tr>
<td>csServer.log</td>
<td>Logs server installation information</td>
<td>HPChem\ChemStor\install</td>
</tr>
<tr>
<td>hparsv.log</td>
<td>Logs archive activity on server</td>
<td>HPChem\ChemStor</td>
</tr>
<tr>
<td>XMLexp.log</td>
<td>Logs XML archive catalog activities</td>
<td>HPChem\ChemStor</td>
</tr>
<tr>
<td>AutoArch.log</td>
<td>Logs activities of the automated archiver</td>
<td>HPChem\ChemStor</td>
</tr>
<tr>
<td>initHPCS.ora</td>
<td>Oracle initialization file</td>
<td>\Oracle\Ora92\database</td>
</tr>
</tbody>
</table>
ChemStore C/S default Users

When you create an empty ChemStore C/S standalone database or a new server database, several users are created for you. Each user is associated with different privileges. For example, you can tell your data entry personnel to log on as user operator, and that user will have only the privileges associated with the operator user.

For each automatically-created user listed in the following table, the default password is the same as the user; for example, the default password for user operator is operator. The passwords are case-sensitive; the user names are not.

Table 12  Default Users

<table>
<thead>
<tr>
<th>User Name</th>
<th>Password</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>admin</td>
<td>admin</td>
<td>Administrative capabilities</td>
</tr>
<tr>
<td>manager</td>
<td>manager</td>
<td>Laboratory manager permissions</td>
</tr>
<tr>
<td>chemist</td>
<td>chemist</td>
<td>Chemist’s permissions</td>
</tr>
<tr>
<td>operator</td>
<td>operator</td>
<td>Create batch only</td>
</tr>
<tr>
<td>support</td>
<td>support</td>
<td>All permissions</td>
</tr>
</tbody>
</table>

See the ChemStore C/S Data Management Module online help for information on creating new users.

Please ensure that there is always one user with full capabilities available in your database, otherwise functionality might be restricted and can not be restored for individual users.

You should change the passwords and/or users after installation to prevent unauthorized user access.
Index

A
access security problems troubleshooting, 120
admin client utility installing, 142
alias, 24, 26
archive server log file clearing, 167
archive strategy, 17
authentication, 40

B
backup, 153

C
changing
   database description, 145
default passwords, 147
checking server services, 140
   client
      hardware requirements, 33
      installation, 67
client installation log file, 123
   client software
      installation, 67
      removing, 125
      requirements, 33
   client/server, 13
      installation, 31
      upgrading, 107
   compression, 19
   configuration
      Net8, 73
connecting to the database, 24, 80, 105
creating
   new database, 22
   Oracle database, 60

D
database
   alias, 24
   changing description, 145
   connecting to, 24, 80, 105
   creating new, 22
   migrating, 104
   database description changing, 145
   database instance
      restarting, 152
      shutting down, 151
   database size, 36
      standalone, 17
   DB Size Security Service
      installation, 28
   default passwords changing, 147
defragmenting the file system, 158, 163

F
file system
defragmenting, 158, 163

H
hardware requirements, 16, 101
   client, 33
   server, 34

I
infrastructure server roles, 40
installation
   client, 67
   client software, 67
   client/server, 31
   DB Size Security Service, 28
   server, 42
   server software, 56
   standalone, 15, 20
installation problems troubleshooting, 122
installing
   admin client utility, 142
   review client, 75

L
licenses, 41
log file
   clearing archive server, 167
   client installation, 123
   server, 122

M
migrating
   database, 104
   standalone databases, 93

N
name
   net service, 50
name resolution problems resolving, 115
net service name, 50
Net8 communications testing, 55, 74
Net8 configuration, 73
Index

Net8 connectivity
troubleshooting, 117

network, 41

network connections
troubleshooting, 114

new database
creating, 22

O

optimizing server configuration, 168

Oracle database
creating, 60

P

passwords
changing default, 147

performance
server, 39

power failure protection, 166

protection
power failure, 166

virus, 165

R

removing
client software, 125

server software, 131

requirements
client hardware, 33

client software, 33

hardware, 16, 101

server hardware, 34

server software, 35

software, 16, 33, 101

resolving name resolution problems, 115

restoring the database instance, 152

restore, 155

results storage requirements, 18

review client, 12

installing, 75

S

server
installation, 42

log files, 122

software requirements, 35

upgrading, 110

server configuration
optimizing, 168

server hardware requirements, 34

server performance, 39

server services
checking, 140

server software
installation, 56

removing, 131

shutting down the database instance, 151

size
database, 36

software requirements, 16, 33, 101

client, 33

server, 35

standalone
installation, 15, 20

review client, 12

upgrading, 84, 99

standalone database size, 17

standalone databases
migrating, 93

storage requirements
results, 18

strategy
archive, 17

T

testing
Net8 communications, 55, 74

troubleshooting
access security problems, 120

installation problems, 122

Net8 connectivity, 117

network connections, 114

U

upgrading

B.01.02 server, 110

client/server, 107

standalone, 99

to client server, 84

V

virus protection, 165
In This Book

This installation guide provides the following information:

Instructions on how to perform both standalone and client/server installations of ChemStore C/S.

Descriptions of various procedures necessary to upgrade from previous revisions of the ChemStore C/S software as well as the procedure to upgrade a standalone system to client/server.

Troubleshooting tips, descriptions of uninstallation tasks, administrative tasks, and reference information.